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`çéóêáÖÜí
© Barco, Inc.  November 17, 2005

All rights reserved.  No part of this document may be copied, reproduced or translated. It 
shall not otherwise be recorded, transmitted or stored in a retrieval system without the prior 
written consent of Barco.

kçíáÅÉ
Barco provides this manual “as is” without warranty of any kind, either expressed or 
implied, including but not limited to the implied warranties or merchantability and fitness for 
a particular purpose. Barco may make improvements and/or changes to the product(s) and/
or the program(s) described in this publication at any time without notice.

This publication could contain technical inaccuracies or typographical errors. Changes are 
periodically made to the information in this publication; these changes are incorporated in 
new editions of this publication.

cÉÇÉê~ä=`çããìåáÅ~íáçåë=`çããáëëáçå=Ec``F=pí~íÉãÉåí
This equipment has been tested and found to comply with the limits for a class A digital 
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area may cause harmful interference, in which case the user will be responsible for 
correcting any interference.

dì~ê~åíÉÉ=~åÇ=`çãéÉåë~íáçå
Barco provides a guarantee relating to perfect manufacturing as part of the legally 
stipulated terms of guarantee. On receipt, the purchaser must immediately inspect all 
delivered goods for damage incurred during transport, as well as for material and 
manufacturing faults Barco must be informed immediately in writing of any complaints.

The period of guarantee begins on the date of transfer of risks, in the case of special 
systems and software on the date of commissioning, at latest 30 days after the transfer of 
risks. In the event of justified notice of compliant, Barco can repair the fault or provide a 
replacement at its own discretion within an appropriate period. If this measure proves to be 
impossible or unsuccessful, the purchaser can demand a reduction in the purchase price or 
cancellation of the contract. All other claims, in particular those relating to compensation for 
direct or indirect damage, and also damage attributed to the operation of software as well 
as to other services provided by Barco, being a component of the system or independent 
service, will be deemed invalid provided the damage is not proven to be attributed to the 
absence of properties guaranteed in writing or due to the intent or gross negligence or part 
of Barco.

If the purchaser or a third party carries out modifications or repairs on goods delivered by 
Barco, or if the goods are handled incorrectly, in particular if the systems are commissioned 
operated incorrectly or if, after the transfer of risks, the goods are subject to influences not
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agreed upon in the contract, all guarantee claims of the purchaser will be rendered invalid. 
Not included in the guarantee coverage are system failures which are attributed to 
programs or special electronic circuitry provided by the purchaser, e.g. interfaces. Normal 
wear as well as normal maintenance are not subject to the guarantee provided by Barco 
either.

The environmental conditions as well as the servicing and maintenance regulations 
specified in this manual must be complied with by the customer.

qê~ÇÉã~êâë
Brand and product names mentioned in this manual may be trademarks, registered 
trademarks or copyrights of their respective holders.  All brand and product names 
mentioned in this manual serve as comments or examples and are not to be understood as 
advertising for the products or their manufactures.

`çãé~åó=^ÇÇêÉëë
Barco Events USA
11101 Trade Center Drive
Rancho Cordova, California  95670
USA

• Phone: (916) 859-2500 

• Fax: (916) 859-2515

• Websites: 

~ www.folsom.com

~ www.events.barco.com

Barco N.V. 
Noordlaan 5
8520 Kuurne
BELGIUM 

• Phone: +32 56.36.82.11 

• Fax: +32 56.35.16.51

• Website: www.barco.com
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léÉê~íçêë=p~ÑÉíó=pìãã~êó
The general safety information in this summary is for operating personnel.

aç=kçí=oÉãçîÉ=`çîÉêë=çê=m~åÉäë
There are no user-serviceable parts within the unit.  Removal of the top cover will expose 
dangerous voltages. To avoid personal injury, do not remove the top cover.  Do not operate 
the unit without the cover installed.  

mçïÉê=pçìêÅÉ
This product is intended to operate from a power source that will not apply more than 230 
volts rms between the supply conductors or between both supply conductor and ground.  A 
protective ground connection by way of grounding conductor in the power cord is essential 
for safe operation.

dêçìåÇáåÖ=íÜÉ=mêçÇìÅí
This product is grounded through the grounding conductor of the power cord.  To avoid 
electrical shock, plug the power cord into a properly wired receptacle before connecting to 
the product input or output terminals.  A protective-ground connection by way of the 
grounding conductor in the power cord is essential for safe operation.

rëÉ=íÜÉ=mêçéÉê=mçïÉê=`çêÇ
Use only the power cord and connector specified for your product. Use only a power cord 
that is in good condition.  Refer cord and connector changes to qualified service personnel.

rëÉ=íÜÉ=mêçéÉê=cìëÉ
To avoid fire hazard, use only the fuse having identical type, voltage rating, and current 
rating characteristics.  Refer fuse replacement to qualified service personnel.  

aç=kçí=léÉê~íÉ=áå=bñéäçëáîÉ=^íãçëéÜÉêÉë
To avoid explosion, do not operate this product in an explosive atmosphere.
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qÉêãë=få=qÜáë=j~åì~ä=~åÇ=bèìáéãÉåí=j~êâáåÖ=

t^okfkd
Highlights an operating procedure, practice, condition, statement, etc., which, if not strictly 
observed, could result in injury to or death of personnel.

`^rqflk
The exclamation point within an equilateral triangle is intended to alert the user to the 
presence of important operating and maintenance (servicing) instructions in the literature 
accompanying the appliance.

^sboqfppbjbkq>
Le point d´exclamation dans un triangle equilatéral signale à alerter l´utilisateur qu´il y a 
des instructions d´operation et d´entretien tres importantes dans la litérature qui 
accompagne l´appareil.

slopf`eq
Ein Ausrufungszeichen innerhalb eines gleichwinkeligen Dreiecks dient dazu, den 
Benutzer auf wichtige Bedienungs-und Wartungsanweisungen in der Dem Great 
beiliegenden Literatur aufmerksam zu machen.

Note Highlights an essential operating procedure, condition or 
statement.
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`Ü~åÖÉ=eáëíçêó
The table below lists the changes to the PresentationPRO-II User’s Guide. 

Table 0-1. Change History

Rev Date ECO # Description Approved By

A 11/17/05 1502 New PresentationPRO-II User’s Guide Andreas Yerocostas
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NK==fåíêçÇìÅíáçå

This chapter is designed to introduce you to the PresentationPRO-II.  Areas to be covered 
are: 

• Chapter Structure

• How to Use This Guide

• Conventions

• Terms and Definitions

• System Overview

`Ü~éíÉê=píêìÅíìêÉ
The following chapters provide instructions for all aspects of PresentationPRO-II 
operations: 

• Chapter 1, “Introduction” provides a system overview, a list of features, and 
discusses easy ways to use this guide.

• Chapter 2, “Hardware Orientation” explains the PresentationPRO-II’s front and 
rear panels in detail. 

• Chapter 3, “Hardware Installation” provides comprehensive system installation 
instructions.    

• Chapter 4, “Menu Orientation” explains the system’s configuration, setup and 
adjustment menus, and provides basic menu “navigation” procedures. 

• Chapter 5, “System Setup” outlines procedures for setting up and configuring the 
PresentationPRO-II.

• Chapter 6, “Operations” provides basic system operating instructions. 

• Appendix A, “Specifications” lists the PresentationPRO-II’s input, output, video, 
mechanical and power specifications, and includes connector pinouts. 

• Appendix B, “Contact Information” lists important contact, RMA, warranty and 
technical support details. 
PresentationPRO-II  •  User’s Guide 1
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NK==fåíêçÇìÅíáçå
How to Use This Guide
eçï=íç=rëÉ=qÜáë=dìáÇÉ
Following are important tips for streamlining your use of this User’s Guide in its electronic 
“PDF” form.

k~îáÖ~íáåÖ
Use Acrobat Reader’s “bookmarks” to navigate to the desired location.  All chapter files 
have the same bookmark structure for instant navigation to any section.   Please note:

• Extensive hyperlinks are provided within the chapters.

• Use Acrobat’s “Go to Previous View” and “Return to Next View” buttons to trace 
your complete navigational path.  

• Use the “Previous Page” and “Next Page” buttons to go to the previous or next 
page within a file. 

• Use Acrobat’s extensive search capabilities, such as the “Find” tool and “Search 
Index” tool to perform comprehensive searches as required.  

q~ÄäÉ=çÑ=`çåíÉåíë=~åÇ=fåÇÉñ
Use the Table of Contents bookmarks to navigate a desired topic.  Click any item to 
instantly jump to that section of the guide.  You can also use the Index to jump to specific 
topics within a chapter.  Each page number in the Index is a hyperlink.

`çåîÉåíáçåë=
The following conventions are used throughout this guide: 

• The symbol  denotes an operations procedure. 

• The symbol  denotes an example.

• Entries written in bold-face letters denote physical buttons or rear chassis 
connectors.  

Press PIP to ... 

• When two buttons together are required for an operation or function, the plus (+) 
sign is used between the buttons.  This procedure requires that you hold down the 
first button, then press the second.   

• Button labels on the Touch Screen menus are shown in bold uppercase letters 
between braces.

Press {BORDER} to …

• When a sequence of menu selections is required to complete a given procedure, 
the ">" symbol is used to divide each successive menu picks.  

To access the Sizing Menu, press {HOME} > {INPUT} > {SIZING}.
2 PresentationPRO-II  •  User’s Guide
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NK==fåíêçÇìÅíáçå
Terms and Definitions
qÉêãë=~åÇ=aÉÑáåáíáçåë
The following terms and definitions are used throughout this guide: 

• A “Background” is an unscaled source, typically originating from a computer.  
PresentationPRO-II enables you to work with one background source which 
appears at the system’s lowest priority — visually in back of all other sources. 

• The abbreviation “BG” is also used throughout this guide for Background.

• A “Key” is an electronic (and visual) process whereby one image is electronically 
superimposed over another source or a background.  Keys are typically used for 
titles and banners.

• A “Layer” is an image display element (such as a PIP, Key or Background) that 
has an associated visual priority — either in front (or in back) of another layer.  

• A “LOGO” is a full screen image that is selected from one of three still frames that 
you can capture with PresentationPRO-II.    

• A “Mixer” is the electronic circuitry that enables you to transition (and scale) PIPs 
and Keys over a background.  PresentationPRO-II has one internal mixer, capable 
of layering either one PIP or one key.

• “Operator” refers to the person who uses the system. 

• “PIP” refers to Picture-in-Picture, an on-screen effect in which one “scaled” picture 
(typically of reduced size) is positioned over a background image.  PIPs can be 
reduced, enlarged, bordered, shadowed, and mixed on and off Program.  

• “Screen” and “Menu” both refer to the Touch Screen menus.

• “System” refers to the PresentationPRO-II. 

• A “Scaler” is the electronic circuitry that enables you to reduce or enlarge source 
images, thus creating PIPs and Keys that can be positioned (and transitioned).
PresentationPRO-II  •  User’s Guide 3
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System Overview
póëíÉã=lîÉêîáÉï
The following topics are discussed in this section:

• PresentationPRO-II High Performance Switcher

• PresentationPRO-II Features

• A Word About Layers

• Effect Combinations

mêÉëÉåí~íáçåmolJff eáÖÜ=mÉêÑçêã~åÅÉ=pïáíÅÜÉê
The PresentationPRO-II is a compact switching system that simplifies the task of 
supporting professional quality visual presentations, such as live events and presentations 
in corporate boardrooms and church services.  PresentationPRO-II is offered in two 
configurations — SDI and HD.

• The SDI Model offers eight analog inputs on HD-15 connectors, one unscaled 
high-resolution DVI input for a background or Downstream Key (DSK) source, 
plus one SD-SDI input.  

• The HD Model also offers eight analog inputs, one DVI input (for a background or 
DSK source), plus one SD-SDI/HD-SDI input. 

Each model combines an eight-input video router, Barco’s high performance proprietary 
Athena scaler, and a full-featured control panel in a single integrated package.  The eight 
universal analog inputs accept standard component and composite analog video formats 
(NTSC, PAL, SECAM), computer resolutions up to UXGA, analog HD formats including 
720p, 1080i, 1080p and Plasma display resolutions.

The Barco Athena scaler features 1:1 pixel sampling, motion adaptive de-interlacing for 
both standard and high definition sources, 3:2 and 2:2 pull down detection, low video delay 
and aspect ratio correction.  The operator can also capture and store still frames for use as 
a background, DSK or LOGO source.  

Each unit incorporates one analog and one DVI output, and supports output computer 
resolutions up to 1600x1200, analog HDTV resolutions (including 720p and 1080p) and 
Plasma display resolutions.  

PresentationPRO-II uses three image layers to produce effects:

• One unscaled live background or DSK layer (shared resource)

• One scaled layer

• One LOGO layer

mêÉëÉåí~íáçåmolJff=cÉ~íìêÉë
Following is a detailed list of PresentationPRO-II features:

• Barco Proprietary Processing

~ 10-bit processing with 1:1 pixel sampling

~ Motion adaptive de-interlacing 

~ 3:2 and 2:2 pull down detect

~ Image cropping and aspect ratio correction
4 PresentationPRO-II  •  User’s Guide
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NK==fåíêçÇìÅíáçå
System Overview
• Low video processing delay, less than 3 input fields

• Capture and storage of still frames for use as a background, DSK or LOGO

• SD-SDI input (SDI Model)

• SD-SDI/HD-SDI Input (HD model)

• Support for input and output resolutions up to UXGA  

• High quality motion adaptive de-interlacing on SD and HD sources

• Analog and DVI program outputs

• 2RU rack-mount chassis

• Native high-resolution background/DSK channel independent of the PIP/Key 
processing channel

• Internal 8 x 1 analog video router for selecting scaler input 

• PIP effects:

~ PIP size from 1/8 to 8x source resolution

~ Adjustable PIP aspect ratio

~ PIP borders, including drop shadows and soft edge

• Transitioning PIP or Key over a background

• Numerous wipe effects, programmable matte color

• Keying

~ Luminance key

~ Color key

• Three assignable, internal frame stores 

• Output synchronization: free-run or vertically locked to NTSC/PAL black burst, 
CSync or HD tri-level sync
PresentationPRO-II  •  User’s Guide 5
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System Overview
^=tçêÇ=^Äçìí=i~óÉêë
PresentationPRO-II is a three layer system, but because the DVI input is shared between 
Background and DSK (and only one can be used at a time), the allocation of the layers is 
still very flexible:

Figure 1-1.  PresentationPRO-II Layers, Example 1

In the layer example above, the DVI input is used as a background, thus the DSK cannot 
be used.  Here, users can layer a PIP or Key over the live DVI background, and place the 
full-screen LOGO on top.

In the layer example below, the DVI input is used as a DSK, thus it cannot be used as a live 
background.  However, if the background layer is configured as a matte color, users can 
layer a PIP or Key over the matte background, use the DSK on top, and place the full-
screen LOGO at the highest priority.

Figure 1-2.  PresentationPRO-II Layers, Example 2

Background (DVI)

Mixer

LOGO

Background (Matte)

Mixer

DSK

LOGO
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System Overview
A layer is defined as an image display element (such as a background, PIP or Key) with an 
associated visual priority.  The mixer itself has one layer, which can be assigned to either 
PIP or Key functionality. 

A typical PresentationPRO-II application is illustrated below.

Figure 1-3.  Layer Illustration — Background, Mixer and DSK

Please note the following important points:

• The full screen LOGO is the highest priority layer.  This image visually appears 
“over” all other layers.

• The Downstream Key (DSK) is the second highest priority layer.  It visually 
appears over the mixer and the background — but it is “under” the LOGO.  

• The high resolution Background is the lowest priority layer, which appears 
“behind” all other layers.    

• Within the mixer, a PIP appears “over” the background and “under” the DSK and 
LOGO.  Effects include mixes, wipes, resizing, adjustable aspect ratio, borders, 
drop shadows and soft edges. 

• Within the mixer, a Key also appears “over” the background and “under” the DSK 
and LOGO.  Effects include luminance key, reverse (invert) key, and color key 
(graphics).  

• Up to eight analog inputs and one SD-SDI or HD-SDI input can be scaled to 
produce PIP or Key effects.

Wilderness

Background (Matte)

PIP

DSK
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System Overview
bÑÑÉÅí=`çãÄáå~íáçåë
This section illustrates the many (but not all) combinations of image effects that you can 
create on the PresentationPRO-II.  Please note:

• In the following illustrations, the specific layers used in creating each effect are 
labeled (e.g., PIP, Key).  

• The symbol ↓↑ denotes a PIP, key or DSK that can transition.  

Example:  PIP ↓↑ indicates that you can dissolve a PIP up or down over a 
background.

The PresentationPRO-II system provides one background, one scalable layer, a DSK and 
a full screen LOGO.  The LOGO, DSK and background are always unscaled.    

jáñÉê=bÑÑÉÅí=N
This effect includes a live (DVI) background and one transitioning PIP.

Figure 1-4.  Effect 1 Diagram

jáñÉê=bÑÑÉÅí=O
This transition is similar to effect 1.  Here, you can transition a Key up or down over the live 
(DVI) background.

Figure 1-5.  Effect 2 Diagram

Important If the DSK is in use, a live DVI background cannot be used.  
This occurs because the BG/DSK Input is shared between 
the DSK and the Background. 

Background (DVI)

PIP  ↑↓

Background (DVI)

Key ↑↓
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jáñÉê=bÑÑÉÅí=P
In this effect, because the DSK is in use, the background must be configured as a matte 
color.  Here, you can transition the DSK over a scaled PIP and the background matte.  

Figure 1-6.  Effect 3 Diagram

jáñÉê=bÑÑÉÅí=Q
This transition is similar to effect 3.  Here, you can transition the DSK over a scaled Key 
and the background matte.

Figure 1-7.  Effect 4 Diagram

jáñÉê=bÑÑÉÅí=R
In this effect, the background is configured as a Still Frame, and thus the DSK cannot be 
used.  Here, you can transition a scaled PIP over a captured still frame.   

Figure 1-8.  Effect 5 Diagram

Background (Matte)

PIP

DSK ↑↓

Background (Matte)

KeyDSK ↑↓

Background (Still Frame)

PIP  ↑↓
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jáñÉê=bÑÑÉÅí=S
In this effect, the background is configured as a matte color.  Here, you can transition a 
scaled PIP under the DSK.   

Figure 1-9.  Effect 6 Diagram

 

Background (Matte)

PIP  ↑↓

DSK
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få=qÜáë=`Ü~éíÉê
This chapter provides detailed information about the PresentationPRO-II’s hardware.  The 
following topics are discussed:

• PresentationPRO-II Rear Panel

• PresentationPRO-II Front Panel

• Use of Color

• Front Panel Sections
PresentationPRO-II  •  User’s Guide 11
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2.  Hardware Orientation
PresentationPRO-II Rear Panel
mêÉëÉåí~íáçåmolJff=oÉ~ê=m~åÉä
The figure below illustrates the PresentationPRO-II rear panel:

Figure 2-1.  PresentationPRO-II Rear Panel 

Following are descriptions of each rear panel connector and section.  

1) SDI Input

One BNC connector is provided for an SD-SDI/HD-SDI input (HD model) or an 
SD-SDI input (SDI model).  This input is directly associated with the SDI source 
button on the front panel’s top row.  

Users can set the input to accept the following:

~ SDI (SMPTE 259M-C, NTSC or PAL).  SDI and HD models.

~ HD-SDI (SMPTE 292M, HDTV).  HD model only.

In Chapter 5, refer to the “Comprehensive Input Setup” section on page 90 for 
input setup instructions.

2) Analog Inputs

Eight 15-pin D connectors are provided for Analog Inputs.  These numbered 
inputs feed the system’s internal 8 x 1 analog router, and correspond directly to 
the eight analog source buttons on the front panel.  

Please note:

~ In Appendix A, refer to the “Analog 15-pin D Connector” section on 
page 126 for pinout details. 

~ Refer to the “Analog Input Flexibility” section on page 14 for additional 
information about each analog input connector.

6

7

31 2 4 5

1) SDI Input 4) Program Outputs 7) Serial Ports

2) Analog Inputs 5) Ethernet Port

3) Background/DSK Input 6) AC Connector
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2.  Hardware Orientation
PresentationPRO-II Rear Panel
3) Background/DSK Input

One DVI connector is provided for a Background or a DSK Input.  The connector 
accepts only digital video.  Please note:

~ Using the BG/DSK Input Setup Menu, the connector’s mode can be set 
to either BG (background) or DSK (downstream key)

~ In the BG mode, users can choose between the live DVI input, a matte 
color or a captured still frame.  

~ In the DSK mode, users can choose between the live DVI input or a 
captured still frame.    

In Appendix A, refer to the “DVI Connector Pinouts” section on page 125 for 
pinout details. 

4) Program Outputs

Two connectors are provided for Program Outputs: 

~ One DVI connector is provided for the Digital Program Output.  This 
output is designed for a digital connection to your projector.  The output 
is digital only, and does not include analog pins.  In Appendix A, refer to 
the “DVI Connector Pinouts” section on page 125 for pinout details. 

~ One 15-pin D connector is provided for the Analog Program Output.  
This output (identical in content to the digital output) is designed for an 
analog connection to your projector — or to an analog monitor.  In 
Appendix A, see the “Analog 15-pin D Connector” section on page 126 
for pinouts.

5) Ethernet Port

One RJ-45 connector is provided for 10/100BaseT Ethernet communications.  
When (optionally) connecting the PresentationPRO-II to an external controller, a 
standard Ethernet hub or switch on an isolated network is recommended.  The 
Ethernet connector is compatible with:

~ Standard RJ-45 Ethernet cables

~ Neutrik EtherCon® series cables

In Appendix A, refer to the “Ethernet Connector” section on page 127 for pinout 
details.

6) AC Connector

One AC Connector is provided to connect the PresentationPRO-II to your 
facility’s AC power source.  The integral switch turns the chassis on and off.

7) Serial Ports

Two 9-pin D connectors are provided for RS-232 serial communications with the 
PresentationPRO-II chassis and for downloading code in the field.  In Appendix A, 
refer to the “Serial Connector” section on page 128 for pinout details.

Important In DSK mode, the background matte color is still available as 
a source, and the color itself can be set from the BG Matte 
Menu.
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2.  Hardware Orientation
PresentationPRO-II Rear Panel
^å~äçÖ=fåéìí=cäÉñáÄáäáíó
Each analog input connector accepts a variety of analog formats including VGA, low-
resolution composite video, S-video and YUV component video.  

• For RGB with H and V sync, use the VGA connector directly.

• Using a VGA (HD-15) to 5xBNC breakout cable, five input combinations are 
possible.  Cells with check marks denote the connections required for the 
indicated format.

Table 2-1. Analog Input Combinations using Breakout Cable

Breakout Cable 
Wire Color

Composite 
Video

S-Video
(Y/C)

YUV
(YPbPr)

RGB
Sync on Green

RGB
Comp Sync

RGB
Separate H V

R  (Chrom)  (Pr)  

G  (Lum)  (Lum)

B  (Pb)

H Sync

V Sync
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2.  Hardware Orientation
PresentationPRO-II Front Panel
mêÉëÉåí~íáçåmolJff=cêçåí=m~åÉä
The figure below illustrates the PresentationPRO-II front panel:

Figure 2-1.  PresentationPRO-II Front Panel 

Following are descriptions of each front panel control feature: 

1) Chassis Handles

Two Chassis Handles are provided for ease of installation and transportation.

2) Touch Screen Menu Section

The Touch Screen Menu Section is used for system configuration, setup and 
operational adjustments of PIPs and keys.  Refer to the “Touch Screen Menu 
Section” heading on page 17 for details.

3) Layer Functions Section

The Layer Functions Section is the operational heart of the PresentationPRO-II, 
enabling you to select layers, modes, and perform transitions.  Refer to the “Layer 
Functions Section” heading on page 19 for details.

4) Source Selection Bus

The Source Selection Bus allows you to choose the PIP or Key source.  

~ On the SDI model, up to eight analog sources plus one SD-SDI source 
can be routed to the PIP or Key.  

~ On the HD model, up to eight analog sources plus one HD-SDI/SD-SDI 
source can be routed to the PIP or Key.

Refer to the “Source Selection Bus” section on page 18 for details.

5) PresentationPRO-II Model

This section displays the PresentationPRO-II model, either SDI or HD.

Figure 2-2.  PresentationPRO-II Model Labels

41 3

52

1) Chassis Handles 3) Layer Functions Section 5) PresentationPRO-II Model

2) Touch Screen Menu Section 4) Source Selection Bus

HD-SDI SDI
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2.  Hardware Orientation
Use of Color
rëÉ=çÑ=`çäçê
Color plays an important “visual” role with the PresentationPRO-II’s front panel buttons:

White buttons are used for sources.

Yellow buttons are used for functions and modes.  A yellow button always applies to the 
active (blinking) layer.  These functions include assigning a PIP or key to the active layer, 
resetting or clearing the layer, and freezing the active layer.  Yellow buttons are also used to 
select both scaled sources (Key, PIP) and unscaled sources (LOGO).   

The Red button is used for transitions.     

The Green button indicates the unscaled input source, which is shared between the 
background and the DSK. 

cêçåí=m~åÉä=pÉÅíáçåë
This section provides detailed descriptions and illustrations of each front panel section.  
The following topics are discussed:

• Touch Screen Menu Section

• Source Selection Bus

• Layer Functions Section

1

PIP

TRANS

BG/DSK
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2.  Hardware Orientation
Front Panel Sections
qçìÅÜ=pÅêÉÉå=jÉåì=pÉÅíáçå
The figure below illustrates the Touch Screen Menu Section.  A sample menu is also 
shown for reference.  

Figure 2-3.  Touch Screen Menu Section

Following are descriptions of each area:

1) Touch Screen

All menus and functions can be accessed by touching (pressing) the desired label 
or button on the Touch Screen itself.  

Example:  Press the {BORDER} button to access the Border Menu.

Example:  Press the V Size line to highlight that line.  You can now adjust 
V Size using the ADJ rotary knob. 

2) Rotary Knobs

Two Rotary Knobs are provided to the right of the Touch Screen.  Each knob 
controls the function that is labeled on the Touch Screen itself, immediately 
adjacent to the knob.  Please note:

~ The Top Knob is generally assigned to navigating fields on the selected 
menu.  For example, turning the knob moves a highlight up and down a 
list of parameters, allowing you to adjust the highlighted function.  This 
knob also adjusts adjacent parameters.

H Position

V Position

V Size  < 58.9%  > 452

-34

H
O
M
E

N
A
V

PIP ADJUSTMENT

S
R
C

H Size  < 37.3%  > 674

70

A
D
J

B
O
R
D
E
R

C
R
O
P

TRACK SIZE

1 2

1) Touch Screen 2) Rotary Knobs
PresentationPRO-II  •  User’s Guide 17

Download from Www.Somanuals.com. All Manuals Search And Download.



2.  Hardware Orientation
Front Panel Sections
~ The Bottom knob is used to adjust the adjacent parameter, as labeled 
on the Touch Screen.  

pçìêÅÉ=pÉäÉÅíáçå=_ìë
The figure below illustrates the Source Selection Bus. 

Figure 2-4.  Source Selection Bus

Each button represents an input that you can assign to a PIP or a key.

• Buttons 1 through 8 correspond to the eight analog inputs on the rear panel.

• The SDI button corresponds to the SD-SDI input (SDI Model) or the SD-SDI / HD-
SDI input (HD Model) on the rear panel.  

Press a button on the Source Selection Bus to assign the source to the blinking PIP or 
Key effect in the Layer Functions Section.  

• A source button that is blinking indicates that the source is “pending.”  It has been 
assigned as the next PIP or Key source, and can be taken to Program with the 
next transition.

• When a source button is lit solid, the source is on Program.  It cannot be modified 
until its associated PIP or Key button is pressed and blinking.  

• One solid source (Program) and one blinking source (pending) can appear on the 
Source Selection Bus simultaneously.

In Chapter 5, refer to the “Comprehensive Input Setup” section on page 90 for details on 
all source setup procedures.  

Important There is no Enter button.  If you adjust a value with the 
knobs, that function or value is immediately active.

6 7 8 SDI1 2 3 4 5

Source Selection
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2.  Hardware Orientation
Front Panel Sections
i~óÉê=cìåÅíáçåë=pÉÅíáçå
The figure below illustrates the Layer Functions Section.  

Figure 2-5.  Layer Functions Section

The buttons in the Layer Functions Section enable you to control the layers and effects 
that transition to and from Program.

Please note the following important points:

• The buttons are arranged from left-to-right in order of visual priority — from the 
background (at the lowest priority) to the LOGO (at the highest visual priority).

• The PresentationPRO-II system enables you to “pend” one transition at a time, 
such as a PIP or Key transition, a background, DSK or LOGO transition, or a 
“clear” function.

• Because the mixer has a single scaler, you cannot transition a PIP and a Key 
simultaneously.  With a PIP on Program, however, you can “pend” a Key.  When 
TRANS is pressed, the PIP transitions off and the Key transitions on.  Similarly, if 
a Key is on Program, you can pend a PIP.  

Following are descriptions of each button’s function.

Background/DSK Button — press to pend either a Background or a DSK transition, 
depending on how the button’s mode is configured (on the BG/DSK Input Setup Menu).  
The button blinks when selected, and the BG/DSK Input Setup Menu appears on the 
Touch Screen.  In Chapter 4, refer to the “Background/DSK Input Setup Menu” section 
on page 74 for details.

PIP — press to pend a PIP transition or modify the active PIP.  The button blinks when 
selected, and the PIP Adjustment Menu appears on the Touch Screen.  In Chapter 4, 
refer to the “PIP Adjustment Menu” section on page 57 for details.

KEY — press to pend a Key transition or modify the active Key.  The button blinks when 
selected, and the Key Adjustment Menu appears on the Touch Screen.  In Chapter 4, 
refer to the “Key Menu” section on page 65 for details.  In Chapter 6, refer to the “Working 
with Layers” section on page 102 for complete instructions on all PIP and key modes.

BG/DSK PIP KEY LOGO FULL
SCREEN

Layer Functions

CLEAR FREEZE RESET TRANS

Note Remember that a live Background and the DSK are mutually 
exclusive.  This occurs because the BG/DSK Input is shared.

BG/DSK

PIP

KEY
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2.  Hardware Orientation
Front Panel Sections
LOGO — press to pend a LOGO transition or select the LOGO source.  The button blinks 
when selected and the Logo Input Setup Menu appears on the Touch Screen.  In 
Chapter 4, refer to the “LOGO Input Setup Menu” section on page 82 for details.  

Please note:

• The logo is the system’s highest priority layer, to which you can assign one of 
PresentationPRO-II’s three internal frame stores.  

• The LOGO layer is often used as a “black preview” function.  If Black is selected 
as the “type” on the Logo Input Setup menu, you can fade to black at any time by 
pending a LOGO transition.

• The logo is not a live input, and does not have an associated key signal.  

FULL SCREEN — press to take the selected (blinking) PIP or Key to full screen.  In each 
case, the source’s height will be used as the parameter that defines the full screen size.

Example:  If a source’s original dimension is 1280 x 1024, pressing FULL 
SCREEN expands (or reduces) that PIP to fill the output screen vertically.  If 
borders are ON, they will be taken into account so that they are visible.

In Chapter 6, refer to the “Using Full Screen” section on page 114 for instructions.

CLEAR — press to “pend” the removal of the currently selected (blinking) layer from 
Program — in the next transition.  For example, you can “clear” a PIP, Key, still frame 
background, DSK or LOGO.  In Chapter 6, refer to the “Working with Layers” section on 
page 102 for instructions.

FREEZE — press to freeze the selected (blinking) PIP or Key on Program.  In Chapter 6, 
refer to the “Using Freeze” section on page 114 for instructions.

RESET — press to reset the current effect (e.g., PIP, Key, crop, etc.) to a nominal default 
value.  You can think of this function as being “context sensitive” — as it resets only the 
current effect, without affecting other modifications.  

Example:  If you adjust a PIP’s size, border and shadow, and wish to reset 
only the border, navigate to the Border Menu and press Reset.

In Chapter 6, refer to the “Using Reset” section on page 114 for details.

TRANS — press to transition the pending layer(s) to or from Program — using either a mix 
or wipe.  The wipe patterns, edge types and transition rates are selected using the Effects 
Menu.  

• In Chapter 4, refer to the “Effects Menu” section on page 53 for menu details.  

• In Chapter 6, refer to the “Working with Transitions” section on page 115 for 
operational procedures.  

LOGO

Important All layers are maintained underneath the LOGO.  For 
example, if you have a PIP and a DSK on Program when you 
transition to the LOGO, when you mix the LOGO off — the 
previous "look" is still there.

FULL
SCREEN

CLEAR

FREEZE

RESET

TRANS
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få=qÜáë=`Ü~éíÉê
This chapter provides comprehensive installation instructions for the PresentationPRO-II 
system’s hardware.  The following topics are discussed:

• Safety Precautions

• Unpacking and Inspection

• Site Preparation

• Rack-Mount Installation

• Cable and Adapter Information

• Input Connection Chart

• Installation
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3.  Hardware Installation
Safety Precautions
p~ÑÉíó=mêÉÅ~ìíáçåë=
For all PresentationPRO-II installation procedures, please observe the following important 
safety and handling rules to avoid damage to yourself and the equipment:

• To protect users from electric shock, ensure that the chassis connects to earth via 
the ground wire provided in the AC power Cord.

• The AC Socket-outlet should be installed near the equipment and be easily 
accessible.

råé~ÅâáåÖ=~åÇ=fåëéÉÅíáçå=
Before opening the PresentationPRO-II shipping box, inspect it for damage.  If you find any 
damage, notify the shipping carrier immediately for all claims adjustments.  As you open 
the box, compare its contents against the packing slip.  If you find any shortages, contact 
your sales representative. 

Once you have removed all the components from their packaging and checked that all the 
listed components are present, visually inspect the system to ensure there was no damage 
during shipping.  If there is damage, notify the shipping carrier immediately for all claims 
adjustments.

páíÉ=mêÉé~ê~íáçå=
The environment in which you install your PresentationPRO-II should be clean, properly lit, 
free from static, and have adequate power, ventilation, and space for all components. 

o~ÅâJjçìåí=fåëí~ää~íáçå
The PresentationPRO-II chassis is designed to be rack mounted and is supplied with front 
rack-mount hardware.  Rear rack-mount brackets are available as a kit and are 
recommended for use when units are mounted in transit cases.  

When rack mounting the PresentationPRO-II chassis, remember the following important 
points:

• Maximum ambient operating temperature for the unit is 40 degrees C. 

• Leave at least one inch of space (front and rear) to ensure that the airflow through 
the fan and vent holes is not restricted. 

• When installing multiple units into a rack, distribute them evenly to prevent 
hazardous conditions that may be created by uneven weight distribution. 

Note The PresentationPRO-II chassis can also be used in a 
“tabletop” configuration, without rack mounting.
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3.  Hardware Installation
Cable and Adapter Information
• Rack mount each PresentationPRO-II chassis from the front rack ears using four 
rack screws (not supplied).  Rack threads may be metric or otherwise — 
depending upon the rack type.  

• Install the lower of the two mounting holes first. 

`~ÄäÉ=~åÇ=^Ç~éíÉê=fåÑçêã~íáçå
The table below provides information regarding cables and adapters:

Table 3-1. PresentationPRO-II System Cables and Adapters

Cable Description Note

Input Connections

HD-15 to 5xBNC Breakout Cable Analog input connectors (via breakout) 4 Cables Supplied

HD-15 to HD-15 Analog input connections (direct) Customer Supplied

DVI to DVI Digital background/DSK connection (direct) Customer Supplied

Belden 1694A (recommended) SD-SDI or HD-SDI input connection Customer Supplied

Belden RG-59 (recommended) Analog connections (via breakout) Customer Supplied

Output Connections

HD-15 to HD-15 Analog Program output (direct) Customer Supplied

DVI to DVI Digital Program output (direct) Customer Supplied

Remote Connections

Ethernet Hub or Switch For use with external controller Customer Supplied

RJ-45 Ethernet Cable For use with external controller Customer Supplied

Power Connections

AC Power Cord AC Power, 7 foot, 10A 1 Cord Supplied
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3.  Hardware Installation
Input Connection Chart
fåéìí=`çååÉÅíáçå=`Ü~êí=
The following Input Connection Chart is provided to assist with your connections.  Please 
note the following important points:

• The mixer has eight analog input connections (scaled), and one SD-SDI input 
(SDI model) or one SD-SDI/HD-SDI input (HD model).  Additionally, there is one 
unscaled DVI connection that is shared between background and DSK.  

• There is a direct correspondence between the first eight buttons on the Source 
Selection Bus and the eight numbered analog input connections.  No additional 
button-to-source configuration is required.

• There is a direct correspondence between the SDI button in the Source 
Selection Bus and the SD-SDI (or SD-SDI/HD-SDI) input connection.  No 
additional button-to-source configuration is required.

• The Analog inputs can also be used to connect composite, S-Video (Y/C) and 
component video.  In Chapter 2, refer to the “Analog Input Flexibility” section on 
page 14 for details.

• If a DVI source is connected to the BG/DSK input, it can be used for either a live 
background or the DSK (but not both simultaneously).  The mode for the BG/DSK 
button (either BG or DSK) is set on the BG/DSK Input Setup Menu.

Chart instructions:

• Column 1 lists all input connectors.  

• Column 2 lists additional connector details.  Remember that the DVI connector is 
digital only.  Be sure to check [  ] the desired assignment of BG/DSK input.

• In Column 3, please list the physical source that supplies the input signal.

• In Column 4, please list any notes or details pertaining to the source.  

Complete the following Input Connection Chart for your system:  

Table 3-2. Input Connection Chart

Input Input Detail Physical Source Note

Analog Input 1 Scaled

Analog Input 2 Scaled

Analog Input 3 Scaled

Analog Input 4 Scaled

Analog Input 5 Scaled

Analog Input 6 Scaled

Analog Input 7 Scaled

Analog Input 8 Scaled

SDI Input •  SD-SDI (SDI model), Scaled
•  SD-SDI/HD-HDI (HD model), Scaled

BG/DSK Input Digital, Unscaled - BG [    ] DSK [    ]
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3.  Hardware Installation
Installation
fåëí~ää~íáçå
The figure below illustrates a block diagram of a basic PresentationPRO-II system.  This 
diagram can be used as reference in the following installation procedure. 

Figure 3-1.  Block Diagram, Basic PresentationPRO-II System

You will need:  

Use the following steps to install PresentationPRO-II:

1. Follow the unpacking procedures as listed in the “Unpacking and Inspection” 
section on page 22. 

2. As required, refer to the “Physical and Electrical Specifications” section on 
page 124 in Appendix A for electrical and mechanical details.

3. As required, refer to the “PresentationPRO-II Rear Panel” section on page 12 in 
Chapter 2 for the locations of all connectors.

Ethernet Hub / Switch

Program Out (Analog)

Program Out (Digital)

Inputs

ProjectorProgram

To External
Controller

Ethernet
(Optional)

Analog Sources to Analog Inputs 1-8

SD-SDI Source to SDI Input (SDI Model)
SD-SDI/HD-SDI Source to SDI Input (HD Model)

DVI Source to BG/DSK Input

Table 3-3. Equipment List, Basic PresentationPRO-II System

Qty. Item Note

1 PresentationPRO-II Chassis

1 Video Projector and cable Customer supplied 

1 Analog Monitor and cable Customer supplied 

1 Ethernet Hub or Switch Customer supplied (Optional, with External Controller)

2 Ethernet cables Customer supplied (Optional, with External Controller)

1 DVI-DVI cable Customer supplied (for BG/DSK input)

1 Video cable Customer supplied (for SD-SDI or HD-SDI input)

TBD Dedicated sources Analog video as required (customer supplied)
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3.  Hardware Installation
Installation
4. If you are rack mounting the PresentationPRO-II chassis, follow the rack mount 
procedures as outlined in the “Rack-Mount Installation” section on page 22.

5. Ethernet Connections (optional, for use with an external controller) — a 
completely “local” network connection is recommended, without IP connections to 
the outside world. 

a. Using an Ethernet cable, connect the PresentationPRO-II’s Ethernet port 
to a Hub or Switch.

b. Connect the Ethernet Hub or Switch to the external controller’s Ethernet 
port.  

6. Source Connections

a. As an important prerequisite, complete the “Input Connection Chart” on 
page 24 to streamline your source installation procedure.  

b. Using the information from the chart, connect the desired sources to the 
analog and digital input connectors as required.

7. Output Connections 

a. One Analog Program Output is provided.  Connect this output to the 
input of your analog projector, or analog Program monitor.  

b. One Digital Program Output is provided:  Connect this output to the 
input of your digital projector, or digital Program monitor.

8. Power Connection — connect an AC power cord to the AC Power Connector 
on the rear of the PresentationPRO-II chassis, and then to AC outlets.  Connect 
AC Power cords (or AC adapters) to all peripheral equipment such as your 
monitor, projector and source devices.  Please note:

~ Connect each unit only to a properly rated supply circuit. 

~ Reliable grounding (earthing) of rack-mounted equipment should be 
maintained.

9. Power On — turn on power to all units.

10. Display Calibration — calibrate the Touch Screen display using the Display 
Settings Menu.  From the Home Menu, press {DISPLAY} > {LCD CAL}, and 
following the prompts to calibrate the display.

This completes the hardware installation procedure.  Please continue with Chapter 4, 
“Menu Orientation.” 
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få=qÜáë=`Ü~éíÉê
This chapter describes all PresentationPRO-II system menus, including how they are 
accessed, the functions that are available, and simple descriptions of each menu tree (in 
block diagram format).  

The following menus are discussed:

• Home Menu

• Input Menu

• Output Menu

• System Menu

• Effects Menu

• Status Menu

• Display Settings Menu

• PIP Adjustment Menu

• Key Menu

• Input Source Adjustment Menu

• Background/DSK Input Setup Menu

• Frame Grab Menu

• LOGO Input Setup Menu

• Remote Control Menu

Note Button labels on the touch screen menus are shown in bold 
upper and lowercase letters between braces.

Press {BORDER} to …
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4.  Menu Orientation
Home Menu
eçãÉ=jÉåì
The figure below illustrates the Home Menu:

Figure 4-1.  Home Menu

The Home Menu is the system’s top level menu, from which all other menus can be 
accessed.  To access a menu, press the desired button on the touch screen.  You can also 
return to the Home Menu by pressing the {Home} button from within an adjustment menu 
itself.  The {Home} button is always the top left button on a screen.  

The following menus can be accessed from the Home Menu: 

• Press {INPUT} to access the “Input Menu.”

• Press {OUTPUT} to access the “Output Menu.”

• Press {SYSTEM} to access the “System Menu.”

• Press {EFFECTS} to access the “Effects Menu.”

• Press {STATUS} to access the “Status Menu.”

• Press {DISPLAY} to access the “Display Settings Menu.”

• Press {FRAME GRAB} to access the “Frame Grab Menu.”

• Press {REMOTE CONTROL} to access the “Remote Control Menu.”

däçÄ~ä=oìäÉë
The following global rules apply to all menus:

• Parameters and values displayed between brackets (e.g., [525] ) cannot be 
changed.

• Press {HOME} to return to the Home Menu.  

• Press {BACK} to return to the menu from which you accessed the current menu.

INPUT

STATUS

OUTPUT

DISPLAY

SYSTEM

FRAME
GRAB

EFFECTS

REMOTE
CONTROL

PresentationPRO II
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4.  Menu Orientation
Input Menu
fåéìí=jÉåì
The following topics are discussed in this section:

• Input Menu Tree

• Input Menu Description

• Input Menu Functions

• Input Pre and Sub Menus

fåéìí=jÉåì=qêÉÉ
The figure below illustrates the Input Menu tree:

Figure 4-2.  Input Menu Tree

All functions, sub menus and “pre-menus” are discussed in the following sections. 

INPUT MENU

H
O
M
E

C
F
G

A
R

SELECT
FORMAT SIZING COLOR

BALANCE
FORCE

ACQUIRE

Input
Configuration

Menu

Aspect Ratio
Menu

Sizing
Menu

Color
Balance

Menu

S
A
V
E

HOME MENU
1

Source Selection

Input
Acquisition

MenuINPUT
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4.  Menu Orientation
Input Menu
fåéìí=jÉåì=aÉëÅêáéíáçå
The figure below illustrates a sample Input Menu:

Figure 4-3.  Input Menu  (sample)

The Input Menu is used to adjust all parameters relating to inputs.  Using the menu, you 
can set all of the configuration options for the selected source.  

There are several ways to access the menu:

• Press {INPUT} on the Home Menu.

• Press PIP or KEY in the Layer Functions Section, then press an input on the 
Source Selection Bus and ensure the button is blinking.  If the Input 
Acquisition Menu appears (because the source has not yet been saved, or 
because video has not been detected), press {INPUT}. 

On the Input Menu, the currently selected input is shown in the menu’s upper right corner 
(e.g., SRC_3).  The menu tracks the selected input, thus, if you switch inputs on the 
Source Selection Bus, the menu is immediately re-assigned to the new input.

fåéìí=jÉåì=cìåÅíáçåë
The following Input Menu functions are provided:

• Format — this line performs two functions:

~ Displays the resolution that is automatically determined by the FORCE 
ACQUIRE function. 

~ Enables you to set the resolution of the incoming source if desired.  Once 
the format is selected manually with the rotary knob, press {SELECT 
FORMAT} to “accept” the selection.  

Input Type

Color Space

Sampling Mode

[ RGB ]

[ RGB ]

[ 1:1 ]
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INPUT MENU SRC_3

C
F
G

S
A
V
E

SELECT
FORMAT SIZING COLOR

BALANCE
FORCE

ACQUIRE

Format    1024 x 768 @ 59.94

Contrast  < % > 100.0

Brightness  < % > 100.0A
R

Gamma 1.0

Input Sync Type H/V

Pulldown Compensation On
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In Appendix A, refer to the “Input and Output Resolutions“ section on page 129 
for additional details regarding resolutions.  

• Input Type — sets the type of input connected to the PresentationPRO-II, such as 
RGB, SD, HD or Composite.  Available choices change depending on the 
selected format.  Selections include RGB, YPbPr, Composite/S-Video, SDI 
and HD SDI.    

• Color Space — sets the input’s color space.  Choices include SMPTE and RGB.  
Note that the system will automatically set the Color Space based on the selected 
Format and Input Type.

• Sampling Mode — sets the sampling mode for the selected input, either 1:1 or 
oversample.  

~ When 1:1 Sampling is selected, the system provides pixel-for-pixel 
sampling, and generally better image quality.  

~ When Oversample is selected, the system performs multiple samples 
for every pixel, with a resulting “softer” image.

• Contrast — sets the input’s contrast.  The adjustment range is from 75% to 
125%.

• Brightness — sets the input’s brightness.  The adjustment range is from 75% to 
125%.

• Gamma — sets the input gamma, enabling you to match the gamma of the 
source.  The adjustment range is from 1.0 to 3.0, in 0.1 increments.

• Input Sync Type — sets the type of sync used by the selected source.  Choices 
include H/V, CSync (composite sync), SOG (sync on green) and Auto.

• Pulldown Compensation — (On/Off)  This function is applicable only for 
standard video (component, s-video, composite) inputs.  The default mode is off.  
The feature should be turned on to process video derived from film material. 

• Sync Slice <mv> — This function selects the sync comparator threshold for 
RGsB (RGB with Sync on Green) or YPbPr analog component video sources.  
The value ranges from 20mV to 280mV and is adjustable in steps of 10mV.  The 
default value is 160mV.  

When PresentationPRO-II detects Macrovision® copy protection on incoming 
YPbPr NTSC/PAL video, the Sync Slice value is repositioned to 60mV to account 
for the reduced amplitude sync pulse.

• Sharpness — sets the input’s sharpness.  The adjustment range is from -10 (soft) 
to 10 (sharp). 

Note Selecting a format manually will automatically default the 
Input Type.  In some cases, the Input Type cannot be 
changed due to the selected resolution. 

Note The default Sync Slice level has been optimized for virtually 
all sources that will be encountered and should rarely, if ever, 
require adjustment.  However, the ability to adjust the Sync 
Slice level is provided to improve sync detection and 
synchronization in cases of extremely noisy RGsB or YPbPr 
video signals.
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• Press {CFG} to display the Input Configuration Menu.  Refer to the “Input 
Configuration Menu” section on page 34 for details.

• Press {AR} to display the Aspect Ratio Menu.  Refer to the “Aspect Ratio Menu” 
section on page 38 for details.

• Press {SAVE} to save the selected input in the designated input file.  

• Press {SELECT FORMAT} to “accept” a manually selected input format.  In 
Appendix A, refer to the “Input and Output Resolutions“ section on page 129 for 
details on all available resolutions.

• Press {SIZING} to display the Sizing Menu.  Refer to the “Sizing Menu” section 
on page 35 for details.

• Press {COLOR BALANCE} to display the Color Balance Menu.  Refer to the 
“Color Balance Menu” section on page 37 for details.

• Press {FORCE ACQUIRE} to force the system to perform the optimum image 
setup.      

fåéìí=mêÉ=~åÇ=pìÄ=jÉåìë
The following pre and sub menus can be accessed from the Input Menu:

• Input Acquisition Menu

• Input Configuration Menu

• Sizing Menu

• Color Balance Menu

• Aspect Ratio Menu

Note Every sub menu under the Input Menu includes a {SAVE} 
button.  This enables you to save the input at any point in the 
adjustment process, regardless of your location within the 
menu tree.  The “save” function uses the information selected 
on the Input Configuration Menu.

Note The FORCE ACQUIRE command only works on the 
selected input — not on all inputs simultaneously.  
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fåéìí=^Åèìáëáíáçå=jÉåì
The figure below illustrates a “pre” menu — the Input Acquisition Menu.

Figure 4-4.  Input Acquisition Menu: No File Saved  (sample)

There are two situations in which the Input Acquisition Menu can appear:

1. After a factory reset has been performed, the Input Acquisition Menu 
automatically appears when you first select a source — but prior to pressing 
TRANS for the first time.  As each source button is pressed, the system acquires 
the video and displays the menu.  The following options are available:

~ Press {SAVE} to save the source and display the Input Menu, or ...

~ Press {INPUT} to display the Input Menu without saving the source.   

In this way, you can quickly acquire and save all nine inputs. 

2. After TRANS has been pressed for the first time, the Input Acquisition Menu will 
appear when you (a) select a source that has not been previously saved, and (b) 
press TRANS to transition that source to Program.  Here also, the menu is 
displayed and you can save the source.   

Once the source has been saved, the Input Acquisition Menu will not be shown again, 
unless the system discovers that video is not present.

If you select a source and there is a video mismatch, if video is not present or if the 
acquisition fails, one of the following messages will appear:

Figure 4-5.  Input Acquisition Menu: Mismatch or No Video  (sample) 

Select INPUT to adjust source

H
O
M
E

INPUT ACQUISITION SRC_3

Source acquired.

S
A
V
E

INPUT

or SAVE to save configuration.

File mismatch or no video
detected.
Check cable connections
for input _______ .
Ensure video source is present.
Select FORCE ACQUIRE once video
is reconnected.

Source acquisition failed.
Check cable connections
for input _______ .
Ensure video source is present.
Select FORCE ACQUIRE once video
is reconnected.
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In this situation, the following actions are recommended:

• Check all cable connections for the selected input.

• With a connection established, press {FORCE ACQUIRE} to perform the optimum 
image setup and automatically display the Input Menu, or ...

• Press {INPUT} to display the Input Menu without performing a FORCE 
ACQUIRE. 

fåéìí=`çåÑáÖìê~íáçå=jÉåì
From the Input Menu, press {CFG} to display the Input Configuration Menu, a sample of 
which is shown below:

Figure 4-6.  Input Configuration Menu  (sample)

Each input has an associated input file that stores all input parameters and settings.  Each 
time an input is selected in the Source Selection Bus, its associated file is recalled. 

The Input Configuration Menu enables you to save the input’s associated file — which 
guarantees that the exact parameters you set are those that are used on air. 

The following functions are provided:

• File Number — sets the file number into which data is stored.  In the current 
version, the file number automatically defaults to the input number and cannot be 
changed. 

• File Name — sets the alphanumeric file name.  In the current version, the file 
name automatically defaults to the input name and cannot be changed.

• Press {SAVE} to save the selected input in the designated input file.  

• Press {DELETE} to delete the selected input file.

File Name [ IFILE_003 ]
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INPUT CONFIGURATION SRC_3

SAVE DELETE

File Number [ 3 ]
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From the Input Menu, press {SIZING} to display one of two Sizing Menus.  These menus 
are context sensitive — they change depending on the Sampling Mode selected on the 
Input Menu.

• If 1:1 Sampling is selected, the 1:1 Sizing Menu appears.

• If Oversample is selected, the Oversample Sizing Menu appears.

Each menu and function is described below.

NWN=páòáåÖ=jÉåì

The figure below illustrates a sample 1:1 Sizing Menu.

Figure 4-7.  1:1 Sizing Menu   (sample)

• Clock Phase — sets the system’s A/D converter, allowing you to select where 
pixels are sampled (ideally, on the pixel’s peak).  The adjustment range is -16 to 
15.  For optimum visual results when adjusting high-resolution computer sources, 
project a burst test pattern and adjust the sampling for the minimum noise.  Refer 
to the “Test Pattern Menu” section on page 42 for information.

• H Total — sets the total pixel count per line.  

• H Active — sets the width of the active area.

• H Position — sets the start of the active area’s horizontal offset from H sync.

• V Total — fixed value which cannot be adjusted.

• V Active — sets the number of vertical lines in the image.  

• V Position — sets the start of the active area’s vertical offset from V sync.

• Press {SAVE} to save the selected input in the designated input file.  

H Active

H Position

V Total

H Total

V Active

V Position

[ 858 ]

720

[ 0 ]

486
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1:1 SIZING SRC_3

Clock Phase 0

123
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E
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Note This field is not adjustable for digital sources (including both 
the DVI and BNC input connectors), or for NTSC and PAL 
sources, regardless of connection type.
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The figure below illustrates a sample Oversample Sizing Menu.

Figure 4-8.  Oversample Sizing Menu  (sample) 

With Oversample enabled, four timing parameters are provided that enable you to adjust 
the image to properly fit the image’s raster box.

• Select and adjust Right Edge, Left Edge, Top Edge or Bottom Edge as 
required, to fit the image precisely in its raster box.

• Press {SAVE} to save the selected input in the designated input file.  

Top Edge

Bottom Edge

Left Edge 606
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Right Edge 4062
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From the Input Menu, press {COLOR BALANCE} to display the Color Balance Menu, a 
sample of which is shown below.

Figure 4-9.  Color Balance Menu  (sample)

The Color Balance Menu changes depending on the selected Input Type.

• When RGB sources are selected, the menu provides individual contrast and 
brightness adjustments for R, G and B.  Adjustment range is -25% to +25%.

~ Adjust Red Contrast and Brightness as required.

~ Adjust Green Contrast and Brightness as required.

~ Adjust Blue Contrast and Brightness as required.

• When Composite, S-Video or YPbPr is selected: 

~ Adjust Saturation as required.  The adjustment range is 75% to 125%.

~ Adjust Hue as required.  The range (in degrees) is -90.0 to 90.0.  

• Press {SAVE} to save the selected input in the designated input file.  

• Press {RESET ALL} to return all parameters to their default values.

Hue 0
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COLOR BALANCE SRC_3

RESET
ALL

Saturation  < % > 100
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Note When the Input Type is YPbPr, the Hue field reads “N/A” 
because Hue does not apply to this type of source.
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From the Input Menu, press {AR} to display the Aspect Ratio Menu, a sample of which is 
shown below.

Figure 4-10.  Aspect Ratio Menu  (sample)

The Aspect Ratio Menu enables you to change the image’s aspect ratio to pre-defined 
configurations, or enter a “custom” configuration if desired.  

• Mode — select 16:9, 5:4, 4:3, 3:2, 1:1 or Custom aspect ratios.

• Ratio — when Custom is selected, the Ratio line appears.  Enter a custom 
aspect ratio as desired.  The field is hidden when pre-defined ratios are selected.

• Press {SAVE} to save the selected input in the designated input file.  

Ratio 1.279
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The following topics are discussed in this section:

• Output Menu Tree

• Output Menu Description

• Output Menu Functions

• Output Sub Menus

lìíéìí=jÉåì=qêÉÉ
The figure below illustrates the Output Menu tree:

Figure 4-11.  Output Menu Tree

All functions and sub menus are discussed in the following sections. 

OUTPUT MENU

H
O
M
E

Settings
Menu

Test
Pattern
Menu

SELECT
FORMAT SETTINGS TEST

PATTERN

HOME MENU

OUTPUT
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The figure below illustrates a sample Output Menu:

Figure 4-12.  Output Menu  (sample)

The Output Menu enables you to configure PresentationPRO-II’s outputs, including the 
ability to show test patterns.  To access the menu:

• Press {OUTPUT} on the Home Menu.

On the menu, note that brief “help” messages are displayed to assist you with format 
selection and EDID programming.

lìíéìí=jÉåì=cìåÅíáçåë
The following Output Menu functions are provided:

• Format — sets the resolution and frame rate at which you want to drive your 
projector.  To minimize synchronization problems, select a frame rate that is 
consistent with your input sources.

Example:   If you are using 59.94 NTSC video inputs, run the output at the 
same rate in order to reduce jutter artifacts.  

After selecting a format with the rotary knob, press {SELECT FORMAT} to 
“accept” the selection.  In Appendix A, refer to the “Input and Output 
Resolutions“ section for details on all available resolutions.

• Color Space — displays the output color space, which is fixed at RGB.

• Press {SAVE} to save all output settings in the output file.   

• Press {SELECT FORMAT} to “accept” an output format.  In Appendix A, see the 
“Input and Output Resolutions“ section for details on available resolutions.

• Press {SETTINGS} to display the Settings Menu.  Refer to the “Settings Menu” 
section on page 41 for details.

• Press {TEST PATTERN} to display the Test Pattern Menu.  Refer to the “Test 
Pattern Menu” section on page 42 for details.

Color Space [ RGB ]
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OUTPUT MENU

S
A
V
E

SELECT
FORMAT SETTINGS TEST

PATTERN

Format 1024x768 @ 59.94

Press SELECT FORMAT to select

the output resolution.

DVI EDID format can be adjusted

to match the output format in

The HOME > SYSTEM > EDID menu.
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The following sub menus can be accessed from the Output Menu:

• Settings Menu

• Test Pattern Menu

pÉííáåÖë=jÉåì
From the Output Menu, press {SETTINGS} to display the Settings Menu, a sample of 
which is shown below.

Figure 4-13.  Settings Menu  (sample)

The Settings Menu enables you to set sync parameters for the monitor and projector 
connected to the system.  

• Sync Out — sets the desired sync value.  Select +H+V, -H-V, +H-V, -H+V or 
CSync. 

• SOG — turns the “sync on green” signal Off or On.  

• Gamma — sets the output gamma to match that of your projector.  The default 
value is 1.0. 

SOG Off
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Gamma 1.0
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From the Output Menu, press {TEST PATTERN} to display the Test Pattern Menu, a 
sample of which is shown below.

Figure 4-14.  Test Pattern Menu  (sample)

The Test Pattern Menu enables you to display a variety of test patterns, for system and 
projector alignment. 

• Type — sets the test pattern.  Choose between:

~ Off

~ H Ramp, V Ramp

~ 100% Color Bars, 75% Color Bars

~ 16x16 Grid, 32x32 Grid

~ Burst

~ 50% Gray, Gray Steps 1, Gray Steps 2

~ White, Black, Red, Green, Blue 

• Raster Box — displays a raster box defined by the exact outer edges of the 
selected output resolution.  For example, if the output is set to 1024 x 768, the 
raster box will encapsulate that exact format.  Please note:

~ The Burst test pattern is the only pattern that is smaller than the selected 
output resolution.  When the Raster Box is enabled, the Burst pattern 
will appear within its boundaries.  

~ The Raster Box can be enabled when the test pattern is Off.
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TEST PATTERN

Type Burst

Raster Box On
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Note When the test pattern is enabled, it assumes the highest 
visual priority and covers all effects beneath.  When disabled, 
the effects once again re-appear.
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The following topics are discussed in this section:

• System Menu Tree

• System Menu Description

• System Menu Functions

• System Sub Menus

póëíÉã=jÉåì=qêÉÉ
The figure below illustrates the System Menu tree:

Figure 4-15.  System Menu Tree

All functions and sub menus are discussed in the following sections.   

SYSTEM MENU
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EDID DVI
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Reset Menu
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The figure below illustrates a sample System Menu:

Figure 4-16.  System Menu  (sample)

The System Menu enables you to configure PresentationPRO-II using various functions 
and sub menus.  To access the menu:

• Press {SYSTEM} on the Home Menu.

póëíÉã=jÉåì=cìåÅíáçåë
The following System Menu functions are provided:

• Press {RESET} to display the Reset Menu.  Refer to the “Reset Menu” section on 
page 48 for details.

• Press {SW VER} to display the Software Version Menu.  Refer to the “Software 
Version Menu” section on page 49 for details.

• Press {DIAG} to display the Diagnostics Setup Menu.  Refer to the 
“Diagnostics Setup Menu” section on page 45 for details.

• Press {CONSOLE} to display the Console Port Setup Menu.  Refer to the 
“Console Port Setup Menu” section on page 50 for details.

• Press {EDID} to display the EDID DVI Input Format Menu.  Refer to the “EDID 
DVI Input Format Menu” section on page 51 for details.

• Press {TECH SUPPORT} to display the Technical Support Menu.  Refer to the 
“Technical Support Menu” section on page 52 for details.

• Press {SAVE} to save all settings in the system file.   
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The following sub menus can be accessed from the System Menu:

• Diagnostics Setup Menu

• Reset Menu

• Software Version Menu

• Console Port Setup Menu

• EDID DVI Input Format Menu

• Technical Support Menu

aá~ÖåçëíáÅë=pÉíìé=jÉåì
From the System Menu, press {DIAG} to display the Diagnostics Setup Menu, a sample 
of which is shown below.

Figure 4-17.  Diagnostics Setup Menu  (sample)

The Diagnostics Setup Menu enables you to perform a variety of diagnostic tests on the 
PresentationPRO-II.  The following functions are provided:

• Reset Rotary Encoders — (Yes/No) determines whether or not you wish to reset 
the rotary encoder values when you exit the Rotary Encoder Menu.

• NVRAM Battery — displays the condition of the system’s NVRAM battery.

• Press {START LED TEST} to begin testing all LEDs.  The test takes several 
minutes to complete.  Press {EXIT} at the conclusion of the test.

• Press {ROTARY ENCODER} to display the Rotary Encoder Menu.  Refer to the 
“Rotary Encoder Menu” section on page 46 for details.

• Press {KEY DETECT} to display the Key Detect Menu.  Refer to the “Key Detect 
Menu” section on page 47 for details.  

NVRAM Battery [  OK  ]
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Reset Rotary Encoders Yes

ROTARY
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From the Diagnostics Setup Menu, press {ROTARY ENCODER} to display the Rotary 
Encoder Menu, a sample of which is shown below. 

Figure 4-18.  Rotary Encoder Menu  (sample)

The Rotary Encoder Menu enables you to test the functionality of each rotary encoder, 
displaying both relative and absolute counts for each.  

• Press {EXIT} to return to the Diagnostics Setup Menu.

1

2

Rotary #E
X
I
T

ROTARY ENCODER DIAGNOSTICS

0

0

RelCnt

0

0

AbsCnt
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From the Diagnostics Setup Menu, press {KEY DETECT} to display the Key Detect 
Menu, a sample of which is shown below. 

Figure 4-19.  Key Detect Menu  (sample)

The Key Detect Menu shows you the key that is pressed, its status (pressed or released) 
its scan code and its location in the button matrix. 

• Press {EXIT} to return to the Diagnostics Setup Menu.

E
X
I
T

KEY DETECTION DIAGNOSTICS

Key Label:

Released

0x81

row=1 col=0

Key Status:

Key Scan Code:

SOURCE 1

Please select any key.
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From the System Menu, press {RESET} to display the Reset Menu:

Figure 4-20.  Reset Menu 

The Reset Menu enables you to perform various system reset functions.  The following 
functions are provided:  

• Reset Type — selects the specific type of reset that you wish to perform. Choose 
between SOFT or FACTORY.   Note that selecting SOFT will not delete any user 
defined configurations, while FACTORY deletes all user configurations.

• Press {RESET} to perform the selected reset operation.  When the confirmation 
screen appears:

~ Press {YES} to start the reset procedure.  An “In Progress” message will 
be displayed. 

~ Press {NO} to cancel the procedure. 
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Note A factory reset will erase any “frame grab” images that have 
been stored in flash memory.
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From the System Menu, press {SW VER} to display the Software Version Menu, a 
sample of which is shown below.

Figure 4-21.  Software Version Menu  (sample)

The Software Version Menu enables you to display and verify the system’s software 
version.  The following functions are provided:  

• PresentationPRO-II — displays the system’s current software version.
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From the System Menu, press {CONSOLE} to display the Console Port Setup Menu, a 
sample of which is shown below.

Figure 4-22.  Console Port Setup Menu  (sample)

The Console Port Setup Menu enables you to set the PresentationPRO-II’s RS-232 
communications parameters for serial port 1.

• Baud Rate —  sets the desired baud rate (9600, 14400, 19200, 28800, 38400, 
57600, 115200).

• Data Bits — sets the desired number of data bits (7 or 8).

• Parity — sets the desired parity (None, Even, or Odd).

• Stop Bits — sets the desired number of stop bits (1 or 2).
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From the System Menu, press {EDID} to display the EDID DVI Input Format Menu, a 
sample of which is shown below.

Figure 4-23.  EDID DVI Input Format Menu  (sample)

The EDID DVI Input Format Menu enables you to update the system’s preferred EDID 
resolution for the BG/DSK input.  

Extended Display Identification Data (EDID) is a VESA standard data format that contains 
information about a display device and its resolution capabilities, both preferred and 
allowed.  The PresentationPRO-II EDID file is stored in non-volatile memory.  This file is 
read by an external computer’s DVI graphic card when the DVI output is connected to the 
PresentationPRO-II’s BG/DSK input connector during boot-up.  

• Format — select the preferred DVI video format with which you want to program 
the PresentationPRO-II’s EDID non-volatile memory

• Current — displays the current EDID video format that resides in memory.

• Press {PROGRAM EDID} to program EDID with the new selected format.  A 
warning message will be shown.  

  

H
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J

EDID DVI Input Format

Format 1280 x 1024 @ 60

PROGRAM
EDID

B
A
C
K

To change EDID for BG/DSK,

select the desired format

and select Program EDID.

[ 1280 x 1024 @ 60 ]Current:

Note This menu is designed for advanced users only.  Do not 
program the EDID unless it is necessary.

Note Once EDID programming is complete on PresentationPRO-II, 
you will be prompted to power down the external computer, 
power it back on again, and then ensure that the computer’s 
format is set to match.
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System Menu
qÉÅÜåáÅ~ä=pìééçêí=jÉåì
From the System Menu, press {TECH SUPPORT} to display the Technical Support 
Menu:

Figure 4-24.  Technical Support Menu  (sample)

The Technical Support Menu lists the current version of PresentationPRO-II software, 
and displays the company’s Technical Support phone number. 
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Phone: 866-374-7878
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Effects Menu
bÑÑÉÅíë=jÉåì
The figure below illustrates a sample Effects Menu:

Figure 4-25.  Effects Menu  (sample)

The Effects Menu allows you to modify and manage effects, including the ability to set the 
transition type, rate and wipe pattern.  The following functions are provided:

• Transition Rate — sets the transition rate that is used when the TRANS button is 
pressed (and a Mix or Wipe pattern is selected).  The transition value is in 0.1 
second increments.

• Transition Type — sets the type of transition that occurs when the TRANS button 
is pressed  — either a Mix, or one of several Wipe patterns.

• Transition Edge — sets the edge width (in pixels) for the selected wipe pattern.   
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EFFECTS MENU

Transition Rate 1.0

Transition Type Mix

Transition Edge 16
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Status Menu
pí~íìë=jÉåì
The Status Menu provides basic software version information, as shown in the sample 
menu below:

Figure 4-26.  Status Menu  (sample)

The following status information is provided: 

• PresentationPRO-II — displays the system’s current software version.
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SYSTEM STATUS

PrePRO II 1.00
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Display Settings Menu
aáëéä~ó=pÉííáåÖë=jÉåì
The Display Settings Menu enables you to adjust the displays brightness and contrast, as 
well as calibrate the display.  A sample menu is shown below:

Figure 4-27.  Display Settings Menu  (sample)

The following display adjustments are provided: 

• Brightness — use the top rotary knob to adjust the display’s brightness.

• Contrast — use the middle rotary knob to adjust the display’s contrast.

• Press {RESET} to return the display’s settings to factory default values.

• Press {LIGHT ADJUST} to adjust the backlight of the front panel buttons.  The 
Keypad Backlight Menu appears.  Refer to the “Keypad Backlight Menu” 
section on page 56 for details.

• Press {LCD CAL} to calibrate the touch screen display to your finger, or to a 
stylus.  Once pressed, you will be prompted to touch the center of a target three 
times.  At the conclusion of the procedure, the display is calibrated and the system 
returns to the Home Menu.
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Display Settings Menu
hÉóé~Ç=_~ÅâäáÖÜí=jÉåì
From the Display Settings Menu, press {LIGHT ADJUST} to display the Keypad 
Backlight Menu, which enables you to adjust the backlight of all “dim” front panel buttons.  
A sample menu is shown below:

Figure 4-28.  Keypad Backlight Menu  (sample)

The following adjustments are provided: 

• Keypad Backlight — use the top rotary knob to adjust the backlight of all “dim” 
(un-selected) front panel buttons.  This adjustment will assist overall button 
visibility in dark control room or stage settings.
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PIP Adjustment Menu
mfm=^ÇàìëíãÉåí=jÉåì
The following topics are discussed in this section:

• PIP Adjustment Menu Tree

• PIP Adjustment Menu Description

• PIP Adjustment Menu Functions

• PIP Adjustment Sub Menus

mfm=^ÇàìëíãÉåí=jÉåì=qêÉÉ
The figure below illustrates the PIP Adjustment Menu tree:

Figure 4-29.  PIP Adjustment Menu Tree

All functions and sub menus are discussed in the following sections. 
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PIP Adjustment Menu
mfm=^ÇàìëíãÉåí=jÉåì=aÉëÅêáéíáçå
The figure below illustrates a sample PIP Adjustment Menu:

Figure 4-30.  PIP Adjustment Menu  (sample)

The PIP Adjustment Menu provides tools that enable you to adjust the active PIP.  To 
access the menu:

• Press the PIP button in the Layer Function Section.  

The menu will immediately appear on the Touch Screen display.  

mfm=^ÇàìëíãÉåí=jÉåì=cìåÅíáçåë
The following PIP Adjustment Menu functions are provided:

• H Size — adjusts the PIP’s horizontal size.  The “%” value indicates the PIP’s size 
as a percentage of the screen’s horizontal resolution.  The numeric value is the 
PIP’s width in pixels.   

• V Size — adjusts the PIP’s vertical size.  The “%” value indicates the PIP’s size as 
a percentage of the screen’s vertical resolution.  The numeric value is the PIP’s 
height in pixels.  

• H Position — indicates the PIP’s position, relative to the horizontal center of the 
screen (00), as measured from the exact center of the PIP.  Thus, the value -34 is 
34 pixels to the left of center.   

• V Position — indicates the PIP’s position, relative to the vertical center of the 
screen (00), as measured from the exact center of the PIP.  Thus, the value 70 is 
70 pixels above center.    

H Position

V Position

V Size  < 58.9%  > 452

-34
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PIP ADJUSTMENT

S
R
C 70

A
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J

B
O
R
D
E
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C
R
O
P

TRACK SIZE

674H Size  < 37.3%  >

Note If you select a source button and both the PIP and KEY 
buttons are off, the system displays a brief prompt:  “PIP or 
KEY must be selected.” 
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PIP Adjustment Menu
• Press {SRC} to display the Input Source Adjustment Menu.  Refer to the “Input 
Source Adjustment Menu” section on page 71 for details.

• Press {BORDER} to display the Border Menu.  Refer to the “Border Menu” 
section on page 60 for details.

• Press {CROP} to display the Crop Menu.  Refer to the “Crop Menu” section on 
page 61 for details.

• Enable {TRACK SIZE} to lock H Size and V Size together.  Regardless of the 
PIP’s current aspect ratio, its size will adjust proportionally when you adjust either 
H or V size.  

When {TRACK SIZE} is disabled, you can do the following: 

~ Adjust H SIZE to adjust only the horizontal size, leaving the vertical size 
alone.  In this way, you can stretch the PIP horizontally.

~ Adjust V SIZE to adjust only the vertical size, leaving the horizontal size 
as is.  In this way, you can stretch the PIP vertically. 

mfm=^ÇàìëíãÉåí=pìÄ=jÉåìë
The following sub menus can be accessed via the PIP Adjustment Menu:

• Border Menu

• Crop Menu

• Shadow Menu

• Image Effects Menu

• Input Source Adjustment Menu

Note To return the PIP to its default size and aspect ratio, press the 
RESET button in the Layer Functions Section.  No other 
parameters (such as Shadow or Border) will be affected.
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PIP Adjustment Menu
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From the PIP Adjustment Menu, the Input Source Adjustment Menu, the Shadow 
Menu or the Image Effects Menu, press {BORDER} to display the Border Menu, a 
sample of which is shown below.

Figure 4-31.  Border Menu  (sample)

The Border Menu enables you to add a border to a PIP, and adjust its shape, style and 
color as desired.  The following functions are provided:  

• Mode — enables or disables the PIP’s border. 

• Style — select one of many border styles, including single color and dual color 
with various combinations of soft edge.

• Color — enables you to individually adjust the border’s Red, Green and Blue 
attributes as desired.

• Size Specified In — select the method by which you want to specify the border 
size, either as a percentage of the PIP size or in pixels.  

• Size — adjust’s the border size, using the method selected on the “Size 
Specified In” line.  Note that if “% of PIP” is selected and you switch to “Pixels,” 
the system auto converts one display method to the other.

• Press {PIP} to return to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 58 for details.

• Press {SHADOW} to display the Shadow Menu.  Refer to the “Shadow Menu” 
section on page 62 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 63 for details.

Color: Red

Style

Size Specified In
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609
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W

Mode On

531

Size  < % of PIP > 10.2

Green

Blue

E
F
X

Note To remove any border effects from the PIP, press the RESET 
button in the Layer Functions Section.  No other parameters 
(such as Size or Crop) will be affected.
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PIP Adjustment Menu
`êçé=jÉåì
From the PIP Adjustment Menu, the Input Source Adjustment Menu, the Key Menu, or 
the Key Adjustment Menu, press {CROP} to display the Crop Menu. 

Figure 4-32.  Crop Menu  (sample)

The Crop Menu lets you crop the sides of a PIP or a Key — individually or proportionally, 
without affecting the size of the source image.  The following functions are provided:  

• H Size — adjusts the PIP or Key’s horizontal size.  The “%” value indicates size as 
a percentage of the screen’s horizontal resolution.  The numeric value is the width 
in pixels.  If {TRACK SIZE} is enabled, H and V crop proportionally.

• V Size — adjusts the PIP or Key’s vertical size.  The “%” value indicates size as a 
percentage of the screen’s vertical resolution.  The numeric value is the height in 
pixels.  If {TRACK SIZE} is enabled, H and V crop proportionally.  

• Crop Type — selects the current type of crop function, either ALL-SIDES, TOP-
LEFT, or BOTTOM-RIGHT. 

• Aspect Ratio Mode — enables you to select one of several standard aspect 
ratios:  16:9, 5:4, 4:3, 3:2 and 1:1.

• Ratio — displays the corresponding ratio based on the selected Aspect Ratio 
Mode:  1.777, 1.25, 1.333, 1.500, 1.000, respectively.  

• Enable the {TRACK SIZE} function to proportionally crop H Size and V Size.  
Disable the function for individual parameter adjustments.

• Press {SRC} to display the Input Source Adjustment Menu.  Refer to the “Input 
Source Adjustment Menu” section on page 71 for details.

• Press {BORDER} to display the Border Menu.  Refer to the “Border Menu” 
section on page 60 for details.

Crop Type

Aspect Ratio Mode

V Size  < 46.9%  > 360

ALL-SIDES
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TRACK SIZE

Ratio 1.333

H Size  < 46.9%  > 480

Note If you select Ratio and make adjustments away from the 
default setting, the Aspect Ratio Mode automatically 
changes to Custom.
PresentationPRO-II  •  User’s Guide 61

Download from Www.Somanuals.com. All Manuals Search And Download.



4.  Menu Orientation
PIP Adjustment Menu
• Press {PIP} to return to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 58 for details. 

pÜ~Ççï=jÉåì
From the Border Menu or the Image Effects Menu, press {SHADOW} to display the 
Shadow Menu, a sample of which is shown below.

Figure 4-33.  Shadow Menu  (sample)

The Shadow Menu enables you place a shadow behind a PIP, and adjust its size, position 
and transparency.  The following functions are provided:  

• Mode — enables or disables the PIP’s shadow. 

• H Size  < % > — adjusts the shadow’s horizontal size as a percentage of the PIP’s 
size.  If {TRACK SIZE} is enabled, H and V size adjust proportionally.

• V Size  < % > — adjusts the shadow’s vertical size as a percentage of the PIP’s 
size.  If {TRACK SIZE} is enabled, H and V size adjust proportionally.

• H Pos  < pixel > — adjusts the shadow’s horizontal position in pixels, as an offset 
from the PIP’s horizontal position.  

• V Pos  < pixel > — adjusts the shadow’s vertical position in pixels, as an offset 
from the PIP’s vertical position.  

• Transparency — adjusts the shadow’s transparency, from 0 (full transparency) to 
1024 (opaque).  

• Enable the {TRACK SIZE} function to adjust the shadow’s H Size and V Size 
proportionally.

• Press {PIP} to return to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 58 for details.

Note To remove any crop effects from the PIP or Key, press the 
RESET button in the Layer Functions Section.  No other 
parameters will be affected.
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PIP Adjustment Menu
• Press {BORDER} to display the Border Menu.  Refer to the “Border Menu” 
section on page 60 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 63 for details. 

fã~ÖÉ=bÑÑÉÅíë=jÉåì
From the Border Menu and Matte Menu, press {EFX} to display the Image Effects Menu:

Figure 4-34.  Image Effects Menu  (sample)

The Image Effects Menu enables you to creatively manipulate the selected PIP or Key:  

• Monochrome Mode — turns chroma on or off.  When the mode is enabled, the 
image is completely monochrome.   

• Red — adjusts the image’s red saturation.  Adjustment range is 0 to 100.   

• Green — adjusts the image’s green saturation.  Adjustment range is 0 to 100.   

• Blue — adjusts the image’s blue saturation.  Adjustment range is 0 to 100.   

• Invert — enables you to invert all image colors.     

Note To remove any shadow effects from the PIP or Key, press the 
RESET button in the Layer Functions Section.  No other 
parameters will be affected.
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Note The Red, Green and Blue adjustments function whether or 
not Monochrome Mode is enabled.

Tip For a sepia tone effect, turn Monochrome Mode on, and set 
Red to 100, Green to 65 and Blue to 10.
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PIP Adjustment Menu
• Hue — adjusts the image’s hue, by rotating color vectors throughout the 360 
degree color spectrum.   

• Mode — In the “Strobe” section, enables or disables the strobe mode which when 
enabled, acts as a programmable freeze.    

• Interval (frames) — In the “Strobe” section, sets the freeze interval.   

• Press {RESET RGB} to reset all image colors to their default values.

• Press {PIP} to return to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 58 for details.

• Press {BORDER} to display the Border Menu.  Refer to the “Border Menu” 
section on page 60 for details.

• Press {SHADOW} to display the Shadow Menu.  Refer to the “Shadow Menu” 
section on page 62 for details.  

Note To remove any image effects from the PIP or Key, press the 
RESET button in the Layer Functions Section.  No other 
parameters will be affected.
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Key Menu
hÉó=jÉåì
The following topics are discussed in this section: 

• Key Menu Tree

• Key Menu Description

• Key Menu Functions

• Key Sub Menus

hÉó=jÉåì=qêÉÉ
The figure below illustrates the Key Menu tree:

Figure 4-35.  Key Menu Tree

All functions and sub menus are discussed in the following sections. 

KEY
MENU

H
O
M
E

Home Menu

C
R
O
P

Crop Menu

Matte Menu

Pip Adjustment Menu
Border Menu
Input Source Adjustment Menu

Key Menu
Image Effects Menu
Key Adjustment Menu

SIZE &
POSMATTE

Key Adjustment
Menu

Key Menu
Matte Menu
Crop Menu

KEY
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Key Menu
hÉó=jÉåì=aÉëÅêáéíáçå
The figure below illustrates a sample Key Menu:

Figure 4-36.  Key Menu  (sample)

The Key Menu provides tools to adjust the active key.  To access the menu:

• Press the KEY button in the Layer Function Section. 

The menu will immediately appear on the Touch Screen display. 

hÉó=jÉåì=cìåÅíáçåë
The following Key Menu functions are provided:

• Key Type — displays the type of key, currently fixed as a “Luma” key.    

• Invert Mode — enables you to invert the key signal.

• Clip — adjusts the threshold of the video that electronically “cuts” into the 
background image.  A hole will be cut into the background anywhere that 
foreground luminance is greater than the clip level.  The hole is then filled with the 
Fill Source.  Adjustment range is 0 to 1023.

• Gain — adjusts the sensitivity of the keyer, enabling you to change the sharpness 
of the keyed image.  Gain only affects the key hole, as set by the clip.  Adjustment 
range is 0 to 1023.99.

• Opacity — enables you to adjust the opacity of the keyed image, from fully 
opaque to fully transparent.  Adjustment range is 0 to 1024.

Invert Mode Off
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Key Type [ Luma ]

MATTE
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Clip

Opacity 624
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Fill Source Self

Note If you select a source button and both the PIP and KEY 
buttons are off, the system displays a brief prompt:  “PIP or 
KEY must be selected.” 
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Key Menu
• Fill Source — determines the video that fills the key hole:

~ Self — fills the hole with the key source video itself, for example, the 
video from a character generator.

~ Matte — fills the hole with a matte color, which can then be adjusted with 
the Matte Menu.  Refer to the “Matte Menu“ section on page 68 for 
details.

• Press {CROP} to display the Crop Menu.  Refer to the “Crop Menu” section on 
page 61 for details.

• Press {MATTE} to display the Matte Menu.  See the “Matte Menu” section on 
page 68 for details.

• Press {SIZE & POS} to display the Key Adjustment Menu.  Refer to the “Key 
Adjustment Menu” section on page 69 for details.  

hÉó=pìÄ=jÉåìë
The following sub menus can be accessed from the Key Adjustment Menu:

• Crop Menu

• Matte Menu

• Key Adjustment Menu

Note To return the Key to its default clip values, press the RESET 
button in the Layer Functions Section.  No other parameters 
will be affected.
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Key Menu
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From the Key Menu or the Key Adjustment Menu, press {MATTE} to display the Matte 
Menu, a sample of which is shown below.

Figure 4-37.  Matte Menu  (sample)

The Matte Menu enables you to adjust the fill color of a matte key.  The following functions 
are provided:  

• Red — adjust the red component of the matte fill as required, from 0 to 1024.

• Green — adjust the green component of the matte fill as required, from 0 to 1024.

• Blue — adjust the blue component of the matte fill, from 0 to 1024.

• Press {KEY} to return to the Key Menu.  Refer to the “Key Menu Description” 
section on page 66 for details.

• Press {EFX} to display the Image Effects Menu.  Refer to the “Image Effects 
Menu” section on page 63 for details.

• Enable the {TRACK RGB} function to adjust Red, Green and Blue proportionally. 
Disable the function to adjust colors individually.

• Press {SIZE & POS} to display the Key Adjustment Menu.  Refer to the “Key 
Adjustment Menu” section on page 69 for details. 
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Note To return all matte values to 512, press the RESET button in 
the Layer Functions Section.  No other parameters will be 
affected.
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From the Key Menu and the Matte Menu, press {SIZE & POS} to display the Key 
Adjustment Menu, a sample of which is shown below.

Figure 4-38.  Key Adjustment Menu  (sample)

The Key Adjustment Menu is virtually identical to the PIP Adjustment Menu — except 
that it pertains to Keys rather than PIPs.  The following functions are provided:  

• H Size — adjusts the Key’s horizontal size in pixels.  The “%” value indicates the 
key’s size as a percentage of the screen’s horizontal resolution.  The numeric 
value is the Key’s width in pixels.  

• V Size — adjusts the Key’s vertical size in pixels.  The “%” value indicates the 
Key’s size as a percentage of the screen’s vertical resolution.  The numeric value 
is the Key’s height in pixels.  

• H Position — indicates the Key’s position, relative to the horizontal center of the 
screen (00), as measured from the exact center of the Key.  Thus, the value -160 
is 160 pixels to the left of center.  

• V Position — indicates the Key’s position, relative to the vertical center of the 
screen (00), as measured from the exact center of the Key.  Thus, the value 64 is 
64 pixels above center.    

• Press {KEY} to return to the Key Menu.  Refer to the “Key Menu Description” 
section on page 66 for details.

• Press {MATTE} to display the Matte Menu.  See the “Matte Menu” section on 
page 68 for details.

• Press {CROP} to display the Crop Menu.  Refer to the “Crop Menu” section on 
page 61 for details.

• Enable {TRACK SIZE} to lock H Size and V Size together.  Regardless of the 
Key’s current aspect ratio, its size will adjust proportionally when you adjust either 
H or V size.  

When {TRACK SIZE} is disabled, you can do the following: 

~ Adjust H SIZE to adjust only the horizontal size, leaving the vertical size 
alone.  In this way, you can stretch the Key horizontally.
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Key Menu
~ Adjust V SIZE to adjust only the vertical size, leaving the horizontal size 
as is.  In this way, you can stretch the Key vertically. 

Note To return the Key to its default size and aspect ratio, press the 
RESET button in the Layer Functions Section.  No other 
parameters will be affected.
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Input Source Adjustment Menu
fåéìí=pçìêÅÉ=^ÇàìëíãÉåí=jÉåì
The following topics are discussed in this section:

• Input Source Adjustment Menu Tree

• Input Source Adjustment Menu Description

• Input Source Adjustment Menu Functions

fåéìí=pçìêÅÉ=^ÇàìëíãÉåí=jÉåì=qêÉÉ
The figure below illustrates the Input Source Adjustment Menu tree:

Figure 4-39.  Input Source Adjustment Menu Tree

All functions and sub menus are discussed in the following sections. 
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Input Source Adjustment Menu
fåéìí=pçìêÅÉ=^ÇàìëíãÉåí=jÉåì=aÉëÅêáéíáçå
The figure below illustrates a sample Input Source Adjustment Menu:

Figure 4-40.  Input Source Adjustment Menu  (sample)

The Input Source Adjustment Menu is virtually identical to the PIP and Key Adjustment 
menus — except that the menu pertains to the source “inside” the PIP or Key, rather than 
the boundaries of the PIP or Key itself.  In this way, for example, a PIP can remain in its 
exact location on screen, but you can scale or re-position the image inside the PIP.

To access the menu:

• Press {SRC} from the PIP Adjustment Menu or the Crop Adjustment Menu.  

fåéìí=pçìêÅÉ=^ÇàìëíãÉåí=jÉåì=cìåÅíáçåë
The following Input Source Adjustment Menu functions are provided:

• H Size — adjusts the input source’s horizontal size.  The “%” value indicates the 
source’s size as a percentage of the original PIP or Key’s horizontal resolution.  
The numeric value is the source’s width in pixels.  

• V Size — adjusts the input source’s vertical size.  The “%” value indicates the size 
as a percentage of the original PIP or Key’s vertical resolution.  The numeric value 
is the source’s height in pixels.  

• H Position — indicates the input source’s horizontal position, relative to its default 
horizontal position (00) with no offset.  Thus, the value 50 is 50 pixels to the right 
of its default position.  

• V Position — indicates the input source’s vertical position, relative to its default 
vertical position (00) with no offset.  Thus, the value -10 is 10 pixels below its 
default position. 

H Position

V Position
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Important The Input Source Adjustment Menu is also used to adjust 
Key sources, and the menu functions are identical.  The only 
difference is the menu’s title:  Key Source Adjustment.
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Input Source Adjustment Menu
• Enable {TRACK SIZE} to lock H Size and V Size together.  Regardless of the 
input source’s current aspect ratio, its size will adjust proportionally when you 
adjust either H or V size.  

When {TRACK SIZE} is disabled, you can do the following: 

~ Adjust H SIZE to adjust only the horizontal size, leaving the vertical size 
alone.  In this way, you can stretch the input source horizontally.

~ Adjust V SIZE to adjust only the vertical size, leaving the horizontal size 
as is.  In this way, you can stretch the input source vertically.    

• From the Input Source Adjustment Menu:

~ Press {PIP} to jump to the PIP Adjustment Menu.  Refer to the “PIP 
Adjustment Menu Functions” section on page 58 for details.

~ Press {BORDER} to display the Border Menu.  Refer to the “Border 
Menu” section on page 60 for details.

~ Press {CROP} to display the Crop Menu.  Refer to the “Crop Menu” 
section on page 61 for details.

• From the Key Source Adjustment Menu:

~ Press {KEY} to jump to the Key Menu.  Refer to the “Key Menu 
Functions” section on page 66 for details.

~ Press {MATTE} to display the Matte Menu.  Refer to the “Matte Menu” 
section on page 68 for details.

~ Press {CROP} to display the Crop Menu.  Refer to the “Crop Menu” 
section on page 61 for details.  

Note To return the input source to its default size and aspect ratio, 
press the RESET button in the Layer Functions Section.  
No other parameters will be affected.
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Background/DSK Input Setup Menu
_~ÅâÖêçìåÇLaph=fåéìí=pÉíìé=jÉåì
The following topics are discussed in this section:

• Background/DSK Input Setup Menu Tree

• Background/DSK Input Setup Menu Description

• Background/DSK Mode

• Background/DSK Input Setup Menu Functions

_~ÅâÖêçìåÇLaph=fåéìí=pÉíìé=jÉåì=qêÉÉ
The figure below illustrates the Background/DSK Input Setup Menu tree:

Figure 4-41.  Background/DSK Input Setup Menu Tree

All functions and sub menus are discussed in the following sections.  
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Background/DSK Input Setup Menu
_~ÅâÖêçìåÇLaph=fåéìí=pÉíìé=jÉåì=aÉëÅêáéíáçå
The Background/DSK Input Setup Menu defines the use of the BG/DSK button — either 
as an unscaled background (BG) or as an unscaled downstream key (DSK).    

To access the menu:

• Press the BG/DSK button in the Layer Functions Section.  This action causes 
the button to blink, enabling setup and modification.   

_~ÅâÖêçìåÇLaph=jçÇÉ
The figure below illustrates the top “Mode” line on the Background/DSK Input Setup 
Menu.  This line determines whether the BG/DSK button will be used as a background or 
as a downstream key, and the choice also determines the subsequent appearance (and 
available functions) on the menu.

Figure 4-42.  Background/DSK Input Setup Menu — Mode Line 

• When “Mode” is set to BG, the BG/DSK button is used as a background, and the 
following functions are available:

~ Use the BG/DSK input (DVI) as the live BG source only (but not a DSK 
source). 

~ Capture a still frame from the BG/DSK input.

~ Use a matte color as the background.

~ Use a captured still frame as the background. 

• When “Mode” is set to DSK, the BG/DSK button is used as a downstream key, 
and the following functions are available:

~ Use the BG/DSK input (DVI ) as the live DSK source, but not a live 
background source). 

~ Capture a still frame from the BG/DSK input. 

~ Use a captured still frame as the background. 

~ Use a matte color as the background.  (In DSK mode, the background 
matte color is still available as a source.)

Important The functions that appear on the Background/DSK Input 
Setup Menu change depending on the selected mode — 
either BG (background) or DSK (downstream key).  Full 
details are provided below.   

Type Matte
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BG/DSK INPUT SETUP

Mode BG
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Background/DSK Input Setup Menu
_~ÅâÖêçìåÇLaph=fåéìí=pÉíìé=jÉåì=cìåÅíáçåë
The figure below illustrates a sample Background/DSK Input Setup Menu: 

Figure 4-43.  Background/DSK Input Setup Menu — BG Mode  (sample)

The following functions are provided on the BG/DSK Input Setup Menu:

• Mode — determines the use of the BG/DSK button.  Refer to the “Background/
DSK Mode” section on page 75 for details.  

• Type — selects the desired background type:

~ When DVI is selected, DVI input video is the background or DSK source.  
In this mode, you can also grab a still frame.

~ When MATTE is selected, a solid color is used as the background (as 
defined on the Background Matte Menu).  Refer to the “Background 
Matte Menu” section on page 77 for menu details.

~ When FG_1, FG_2 or FG_3 is selected, a captured still frame is used as 
the background.  This background type cannot be selected until one or 
more frames have been captured. 

• Format — this line performs two functions:

~ Displays the resolution that is automatically determined by the FORCE 
ACQUIRE function. 

~ With DVI selected, enables you to manually set the resolution of the 
background source.  Once the format is selected with the rotary knob, 
press {SELECT FORMAT} to “accept” and activate the selection.  

• For the two Crop settings:

~ If the background input resolution matches the output resolution, or if the 
output resolution is larger than the background input resolution, the Crop 
settings will be bracketed.  

~ If the background input resolution is larger than the output resolution, the 
H Offset and V Offset values can be used to choose which portion of the 
background you want to display.  

~ Press {RESET} to reset the H and V offsets to 0.  

Format 1024 x 768 @ 60
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4.  Menu Orientation
Background/DSK Input Setup Menu
• Matte color can be adjusted in each mode.  

~ In BG mode, if Matte is selected as the Type, use the {MATTE} button.

~ In DSK mode, if DVI is selected as the Type, use the {BG MATTE} 
button.  

Refer to the “Background Matte Menu” section on page 77 for details.

• In both BG and DSK modes, if DVI is selected as the Type, a “help” message is 
provided for updating the system’s preferred EDID resolution for the BG/DSK 
input.  Refer to the “EDID DVI Input Format Menu” section on page 51 for details.

• In DSK mode, press {KEY} to access the DSK Adjustment Menu.  Refer to the 
“DSK Adjustment Menu” section on page 78 for details.  

• Press {SAVE} to store all selected background settings.

• Press {RESET} to reset the H and V “Crop” offsets to 0, if required.

• Press {SELECT FORMAT} to “activate” the selected background format.

• Press {FRAME GRAB} to display the Frame Grab Menu.  Refer to the “Frame 
Grab Menu” section page 80 on for details.

• Press {FORCE ACQUIRE} to automatically detect the input signal resolution and 
update the display Format field accordingly.  

_~ÅâÖêçìåÇ=j~ííÉ=jÉåì
The figure below illustrates a sample Background Matte Menu:

Figure 4-44.  Background Matte Menu  (sample)

The Background Matte Menu enables you to create a solid background matte color to use 
behind your PIPs and Keys.    

• Red — adjust the red component of the background matte color as required, from 
0 to 1024.

• Green — adjust the green component of the background matte color as required, 
from 0 to 1024.
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4.  Menu Orientation
Background/DSK Input Setup Menu
• Blue — adjust the blue component of the background matte color as required, 
from 0 to 1024.  

aph=^ÇàìëíãÉåí=jÉåì
From the Background/DSK Input Setup Menu, press {KEY} to access the DSK 
Adjustment Menu, a sample of which is shown below:

Figure 4-45.  DSK Adjustment Menu  (sample)

The DSK Adjustment Menu enables you to adjust key and fill parameters for the DSK 
source.  The following functions are provided:

• Key Type — displays the type of DSK key, currently fixed as a “Luma” key.    

• Invert Mode — enables you to invert the DSK signal.

• Clip — adjusts the threshold of the video that “cuts” into the background.  A hole 
will be cut anywhere that foreground luminance is greater than the clip level.  The 
hole is then filled with the Fill Source.  Adjustment range is 0 to 1023.

• Gain — adjusts the keyer sensitivity, enabling you to change the key’s sharpness.  
Gain only affects the key hole.  Adjustment range is 0 to 1023.99.

• Opacity — enables you to adjust the key’s opacity, from fully opaque to fully 
transparent.  Adjustment range is 0 to 1024.

• Fill Source — determines the video that fills the key hole:

~ Self — fills the hole with the key source video itself (e.g., video from a 
character generator).  

~ Matte — fills the hole with a matte color, which can then be adjusted with 
the DSK Matte Adjustment Menu.  Refer to the “DSK Matte 
Adjustment Menu“ section on page 79 for details.

• Press {INPUT SETUP} to display the BG/DSK Input Setup Menu.  Refer to the 
“Background/DSK Input Setup Menu Functions” section on page 76 for details.  

Note The default state is a black matte color.

Invert Mode Off
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4.  Menu Orientation
Background/DSK Input Setup Menu
• Press {MATTE} to display the DSK Matte Adjustment Menu.  This softkey only 
appears when the Fill Source is set to Matte.  Refer to the “DSK Matte 
Adjustment Menu” section on page 79 for details.  

aph=j~ííÉ=^ÇàìëíãÉåí=jÉåì
From the DSK Adjustment Menu, press {MATTE} to display the DSK Matte Adjustment 
Menu, a sample of which is shown below:

Figure 4-46.  DSK Input Setup Menu  (sample)

The DSK Matte Adjustment Menu enables you to adjust the fill color of a matte key.  The 
following functions are provided:  

• Red — adjust the red component of the matte fill as required, from 0 to 1024.

• Green — adjust the green component of the matte fill as required, from 0 to 1024.

• Blue — adjust the blue component of the matte fill, from 0 to 1024.

• Enable the {TRACK RGB} function to adjust Red, Green and Blue proportionally. 
Disable the function to adjust colors individually.
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Frame Grab Menu
cê~ãÉ=dê~Ä=jÉåì
The figure below illustrates a sample Frame Grab Menu:

Figure 4-47.  Frame Grab Menu  (sample)

The Frame Grab Menu enables you to capture still frames into the system’s three internal 
frame stores.  The “source” of the still frames is the system’s BG/DSK input or the scaled 
inputs.  

Once captured, a still frame can be assigned as the input “type” for BG, the DSK or the 
LOGO source.  

The three frame stores utilize PresentationPRO-II’s “temp” (temporary) memory for on-air 
production.  During operation, you can overwrite the memory with new captured stills as 
desired — as it takes only a few seconds to capture a still.  Note that stills in “temp” 
memory are lost when the system is powered down.

You can also store three stills in “permanent” flash memory, which will not be lost when the 
system is powered down.  At bootup, the contents of flash memory is read into “temp” 
memory for use on-air.  It takes several minutes to save a still into permanent memory, and 
this procedure should not be performed on-air.  Permanent frames can also be overwritten.  
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Note The contents of a layer can also be captured.  In Chapter 6, 
refer to the “Capturing Still Frames” section on page 117 for 
details. 
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Frame Grab Menu
To access the Frame Grab Menu, use one of the following methods:

• Press {FRAME GRAB} from the BG/DSK Input Setup Menu, when “Type” is set 
to DVI (in both the BG and DSK modes).

• Press {FRAME GRAB} from the Home Menu.   

The following Frame Grab Menu functions are provided:

• FG to Capture — enables you to select FG_1, FG_2 or FG_3 for capture.

• Capture Format — displays the output resolution.  PresentationPRO-II always 
captures a full screen image at the output resolution — regardless of the input 
resolution.

• In the Temp FG Info section:

~ File Name — displays the name of the file in “temp” memory.  

• The “_T” in the filename indicates that the file’s source is 
temporary memory.  

• The “_P” in the filename indicates that the file is permanently 
stored.  If this indication appears, the permanent file has been 
read into “temp” memory for use on-air.

~ Format — displays the resolution of the captured frame.

• In the Perm FG Info section:

~ File Name — displays the name of the file in permanent memory.  

• The “_P” indicates that the file is permanently stored.  

• [EMPTY] indicates that no frame is stored.

~ Format — displays the resolution of the permanent frame.

• Press {CAPTURE} to capture a still into the selected frame store.  Once pressed, 
the screen will indicate that the frame is being captured.

• Press {SAVE} to save the captured frame into permanent memory (FG_1, FG_2 
or FG_3).  Once pressed, the screen will display a warning:

Figure 4-48.  Background Frame Save Warning

~ Press YES to save the frame.  All front panel controls will be locked for 
up to three minutes.

~ Press NO to cancel the procedure.

• Press {DELETE} to delete the selected frame from permanent storage.  This 
button only appears when frames are stored in permanent memory. 

Note The top line of the menu will change accordingly, depending 
on the access path.

System controls will be locked
for 2 to 3 minutes while saving.

Save Now?
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LOGO Input Setup Menu
ildl=fåéìí=pÉíìé=jÉåì
The figure below illustrates a sample LOGO Input Setup Menu:

Figure 4-49.  LOGO Input Setup Menu  (sample)

The LOGO Input Setup Menu enables you to select the full screen source for the panel’s 
LOGO button.  Choose between the three internal frame stores, or black.  Because the 
LOGO is the highest priority layer and downstream of all other effects, the “black” source 
can serve as a convenient way to fade all effects to black — without changing any of the 
image setups underneath the LOGO.  

To access the menu:

• Press the LOGO button in the Layer Functions Section.

The following LOGO Input Setup Menu functions are provided:

• Type — enables you to select still frames FG_1, FG_2, FG_3 or Black as the 
LOGO source.  Frames cannot be captured from the Logo Input Setup Menu.  
Refer to the “Frame Grab Menu” section on page 80 for details.  

• In the Temp FG Info section:

~ File Name — displays the selected still frame’s temporary storage 
register.

~ Resolution — displays the resolution of the selected still frame.

• Press {SAVE} to save all LOGO parameters in memory.
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Note On factory reset, “black” is the default LOGO source.  If you 
capture a frame and assign it as the LOGO source, that 
frame will be the default upon power up.  
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Remote Control Menu
oÉãçíÉ=`çåíêçä=jÉåì
The figure below illustrates a sample Remote Control Menu:

Figure 4-50.  Remote Control Menu  (sample)

The Remote Control Menu serves two purposes:

• When using PresentationPRO-II on a standalone basis, the Remote Control 
Menu is used to set communications parameters for downloading software 
updates via Ethernet.

• When PresentationPRO-II is controlled from an external controller, the Remote 
Control Menu is used to set the unit ID and enable/disable remote control itself.

To access the menu:

• Press {REMOTE CONTROL} on the Home Menu.  

The following functions are provided:

• Unit ID — When PresentationPRO-II is controlled from an external controller, this 
function sets the ID of the PresentationPRO-II chassis.  The ID range is 1 to 32.  

Unit IP:   192.168.0.10

Remote Control

Ctrlr IP:

[ Off ]

[ N/A ]

N
A
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REMOTE CONTROL

Unit ID [ 1 ]

- - - - -  STATUS  - - - - -

No Connection

SAVE

Destination

Router [ Internal ]

[ Undefined ]
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Important Some external controllers will detect multiple IDs and prompt 
the user to correct the problem.  Only the first device will 
connect to the console.  Other devices with conflicting IDs will 
be refused a connection.
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Remote Control Menu
• Remote Control — enables or disables remote control.  

~ When remote control is on, the {HOME} buttons disappears, the 
PresentationPRO-II front panel is disabled, and all control originates 
from the external controller’s console.  

~ To re-establish “local” control, remote control must be turned off from the 
Remote Control Menu.

• Unit IP — displays the IP address of PresentationPRO-II.  

~ When remote control is on, this address will be assigned by the external 
controller’s DHCP server.

~ When remote control is on, you can change the PresentationPRO-II 
static IP address.  When you navigate to the field, the “ ^ “ symbol 
appears below the first quad, and a {NEXT IP QUAD} button appears:

• Use the ADJ knob to change the quad’s setting. 

• Press {NEXT IP QUAD} to advance to the next quad.

• When you reach the last quad, the {SET IP} button appears.  
Press {SET IP} to store the unit’s new Static IP address.

In the “Status” section:

• The top line indicates the connection status with the external controller (e.g., Not 
Connected, Establishing Connection, Connected, etc.). 

• Ctrlr IP — With a connection established, displays the IP address of the external 
controller.

• Destination —  with a connection established, displays the destination assigned 
to PresentationPRO-II by the external controller.

• Router —  with a connection established, displays the utilization of routers:

~ [Internal] indicates that PresentationPRO-II’s local router is used for 
source connections (the eight rear-panel analog connections plus the 
two rear-panel SD/HD connections).

~ [External] indicates that an external (upstream) router is used for source 
connections to PresentationPRO-II.  In this case, and a minimum of rear-
panel PresentationPRO-II connections are used — connected directly to 
one or more router outputs.

In Chapter 6, refer to the “Using Remote Control” section on page 116 for additional 
details.
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This chapter provides detailed instructions for setting up the PresentationPRO-II system.  It 
is recommended that you follow all procedures in the order outlined below:

• Setup Prerequisites

• Return to Factory Default

• Touch Screen Calibration

• Output Setup

• Projector Setup

• Quick Input Setup Procedure

• Comprehensive Input Setup

• Setting up the Background

• Setting up the DSK

• Setting up the LOGO

• Saving the Setup
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5.  System Setup
Setup Prerequisites
pÉíìé=mêÉêÉèìáëáíÉë
Please note the following important setup prerequisites:

• Ensure that you are familiar with Touch Screen operations.  In Chapter 2, refer to 
the “Touch Screen Menu Section” heading on page 17 for instructions.

• In this chapter, when a procedure tells you to “scroll to” a certain line, use the 
rotary knob labelled NAV to move the highlight — or simply touch the desired line 
to highlight it.  

• When a procedure tells you to “adjust” or “select” a certain parameter, use the 
ADJ rotary knob. 

Figure 5-1.  Menu Navigation

Please continue with the “Return to Factory Default” section on page 87.

Preview

HD_15

SD YUV

SMPTE

[ 1:1 ]

N
A
V

A
D
J

SRC_3

ASPECT
RATIO

1

100.0

100.0
86 PresentationPRO-II  •  User’s Guide

Download from Www.Somanuals.com. All Manuals Search And Download.



5.  System Setup
Return to Factory Default
oÉíìêå=íç=c~Åíçêó=aÉÑ~ìäí
Prior to starting your setup procedures, it is recommended that you perform a factory reset.  
This procedure guarantees that any previous setups (e.g., those that may have been 
programmed by other users), do not remain in system memory.

Please note the following important factory default prerequisite:

• Ensure that you are familiar with the Reset Menu.  In Chapter 4, refer to the 
“Reset Menu” section on page 48 for details.

Use the following steps to return the system to factory default values:

1. From the Home Menu, press {SYSTEM} to access the System Menu.

2. From the System Menu, press {RESET} to display the Reset Menu. 

3. On the Reset Type line, select FACTORY.   

4. Press {RESET}.  When the confirmation screen appears, press {YES} to reset the 
system to factory default values.

At the conclusion of the factory reset, the system will have the following basic attributes:

• The Home Menu displayed.

• All files have been erased from memory.

• No inputs are selected.

• The PIP button is selected and blinking.

• The output resolution is set to XGA:  1024x768 @ 59.94  

• The output raster box is Off.  

Please continue with the “Touch Screen Calibration” section on page 87.

qçìÅÜ=pÅêÉÉå=`~äáÄê~íáçå
Calibrating the Touch Screen is an excellent prerequisite to all setup (and operations) 
procedures.

Use the following steps to calibrate your Touch Screen display:

1. If required, press {HOME} to display the Home Menu.

2. Press {DISPLAY} to show the Display Settings Menu.

3. Press {LCD CAL} to display the first Touch Screen Calibration Menu.  

4. Follow the directions on screen to complete the calibration procedure. 

Please continue with the “Output Setup” section on page 88.
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lìíéìí=pÉíìé
Please note the following important output setup prerequisite:

• Ensure that you know your projector’s native resolution.  Refer to your projector’s 
technical manual for details.

Use the following steps to set up the PresentationPRO-II output.   

1. From the Home Menu, press {OUTPUT} to access the Output Menu.  

2. On the Format line, select your projector’s native resolution, and a frame rate that 
is consistent with your inputs.

Example:  If you are using 59.94 NTSC video inputs, run the output at the 
same rate in order to be synchronous.  

In Appendix A, refer to the “Input and Output Resolutions“ section on page 129 
for details on all available resolutions.

3. After selecting a format, press {SELECT FORMAT} to “accept” the selection.  

4. Press {SAVE} to save all output settings in the output file.

Please continue with the “Projector Setup” section on page 88.

mêçàÉÅíçê=pÉíìé
Please note the following important projector setup prerequisite:

• Ensure that you are familiar with the Output Setup Menu and all sub menus 
included on that screen.  In Chapter 4, refer to the “Output Menu Functions” 
section on page 40 for details.

Use the following steps to set up your projector.   

1. From the Home Menu, press {OUTPUT} to access the Output Menu.  

2. Press {TEST PATTERN} to access the Test Pattern Menu.

a. Scroll to the Type line and select the Burst test pattern.

b. Scroll to the Raster Box line and enable the Raster Box.

c. At the projector itself, perform the following adjustments to ensure that 
the PresentationPRO-II output data is properly displayed:

• Adjust the image for a minimum amount of noise

• Adjust the image such that the entire Raster Box is visible. 

d. Once the projector is properly set, disable the Raster Box and select the 
100% Color Bars test pattern.

Note The PresentationPRO-II output format must match your 
projector’s native resolution.

Note Refer to your projector’s technical manual for information on 
all projector setup and adjustment procedures. 
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e. Press {BACK} to return to the Output Menu.

3.  Press {SETTINGS} to display the Settings Menu.

a. Scroll to the Sync Out line and set the desired sync value.   

b. Scroll to the SOG line and enable or disable “sync on green” as required.  

c. Scroll to the Gamma line and set output gamma to match your projector.

d. Press {BACK} to return to the Output Menu.  

4. Press {SAVE} to save all output settings in the output file.

5. At the projector itself, perform additional setup procedures (e.g., color balance, 
alignment, etc.) as required.  

6. When all procedures are complete, press {TEST PATTERN} to access the Test 
Pattern Menu, and turn off the test pattern and raster box. 

Please continue with the “Quick Input Setup Procedure” section on page 89.

nìáÅâ=fåéìí=pÉíìé=mêçÅÉÇìêÉ
This procedure enables you to quickly acquire and save inputs.  Please note the following 
important prerequisites:

• Ensure that you have completed your input connection chart.  In Chapter 3, refer 
to the “Input Connection Chart” section on page 24 for details and instructions.

• Ensure that all inputs are properly connected to the chassis.

• Ensure that the system has been “factory” reset.  Refer to the “Return to Factory 
Default” section on page 87 for details.  After a factory reset, the PIP button will 
be blinking, and no sources will be selected on the Source Selection Bus.

Use the following steps to perform a quick input setup:

1. On the Source Selection Bus, press an input button, then press TRANS to view 
the source on Program.  The system will attempt to acquire the input, and the 
Input Acquisition Menu will be displayed.  

2. If the “Source Acquired” message appears, the acquisition was successful.  
Press {SAVE} to display the Input Menu for the selected source, which enables 
you to fine tune the input if desired.  Refer to the “Comprehensive Input Setup” 
section on page 90 for details.

3. If an error message appears on the Input Acquisition Menu, first check all cable 
connections.  You can then:

~ Press {FORCE ACQUIRE} to re-attempt acquisition, or ...

~ Press {INPUT} to display the Input Menu without performing a FORCE 
ACQUIRE, and manually adjust input parameters. 

4. Repeat from step 1 for all remaining inputs.  

Important If you do not press {SAVE} for a selected input, the Input 
Acquisition Menu will continue to appear whenever that 
source button is pressed.
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Please note: 

• When all inputs have been acquired and saved, the Input Acquisition Menu will 
only re-appear in case of LOS (Loss of Signal), or a mismatch between the saved 
file and incoming video.  In Chapter 6, refer to the “A Word About LOS” section 
on page 101 for details on LOS.

• If you need to fine tune your inputs (or if you change inputs), the Input Menu can 
be accessed at any time by pressing {HOME} > {INPUT}. 

Please continue with the “Comprehensive Input Setup” section on page 90.

`çãéêÉÜÉåëáîÉ=fåéìí=pÉíìé
This procedure enables you to perform a more comprehensive input setup, if required.      

Please note the following important input setup prerequisites:

• Ensure that you are familiar with the Input Menu and all sub menus included on 
that screen.  In Chapter 4, refer to the “Input Menu Functions” section on 
page 30 for complete details.

• Ensure that you have completed your input connection chart.  In Chapter 3, refer 
to the “Input Connection Chart” section on page 24 for details and instructions.

Use the following steps to set up inputs:  

1. In the Layer Functions Section, press PIP.

2. On the Source Selection Bus, select the input that you want to set up.  The 
button will blink.   

3. From the Home Menu, press {INPUT} to access the Input Menu. 

a. On the menu’s top row, ensure that the selected input is correct (e.g., 
SRC_1 or SRC_4).

b. If required, press {FORCE ACQUIRE} to force the system to perform the 
optimum setup on the selected input.  If the operation is successful, the 
Format, Input Type and Color Space fields should correctly reflect the 
characteristics of the incoming signal.

c. If required, scroll to the Format line and manually set the resolution of 
the incoming source.  In Appendix A, refer to the “Input and Output 
Resolutions“ section on page 129 for details on all available resolutions.

d. If you manually selected a format in the previous step, press {SELECT 
FORMAT} to “accept” and activate the selection.  

e. If required, scroll to the Input Type line and set the type of input 
connected to the chassis.  Remember that available choices change 
depending on the selected Format.  

Note If your initial input acquisition was successful (as performed in 
the “Quick Input Setup Procedure” section on page 89), 
there is generally no need to perform all steps in the 
“comprehensive” setup.  Typically, you may wish to adjust 
input “sizing” to properly fit each input within the PIP’s 
boundaries — so that no black edges are visible.
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Comprehensive Input Setup
f. If required, scroll to the Color Space line and set the input’s color space.  
Choices include SMPTE and RGB.  Note that the system may 
automatically set the Color Space based on the selected Format.

g. If required, scroll to the Sampling Mode line and set the sampling mode 
for the selected input — either 1:1 or oversample.

h. Scroll to the Contrast line and set the input’s contrast as desired.

i. Scroll to the Brightness line and set the input’s brightness as desired.  

j. Scroll to the Gamma line and set the input gamma as desired.

k. Scroll to the Input Sync Type line and set the type of sync used by the 
selected source.  Choices include H/V, CSync (composite sync), SOG 
(sync on green) and Auto.

l. For a video source that contains film transfer material, scroll to the 
Pulldown Compensation line and enable or disable 3:2 sequence 
detection.

m. Scroll to the Sync Slice line and adjust the threshold if desired.

n. Scroll to the Sharpness line and set the input’s sharpness as desired.  
The adjustment range is from -10 (soft) to 10 (sharp).

o. Press {SAVE} to save the selected input in the designated file.  

p. Press {BACK} to return to the Input Menu.    

4. Press {SIZING} to access the Sizing Menu.  This menu is context sensitive — it 
changes depending on the selected Sampling Mode.

a. If 1:1 Sampling is selected, adjust Clock Phase, H Total, H Active, 
H Position, V Total, V Active and V Position as required.

b. If Oversample is selected, adjust Right Edge, Left Edge, Top Edge or 
Bottom Edge as required, to fit the image precisely in its raster box.

c. Press {SAVE} to save the selected input in the designated file.

d. Press {BACK} to return to the Input Menu.

5. Press {COLOR BALANCE} to access the Color Balance Menu.   

a. For RGB sources, adjust Red, Green and Blue Contrast and 
Brightness as required.

b. For Composite, S-Video or YPbPr sources, adjust Saturation and Hue 
as required.

c. If required, press {RESET ALL} to return to default values.

d. Press {SAVE} to save the selected input in the designated file.

e. Press {BACK} to return to the Input Menu.

Note The default Sync Slice level has been optimized for virtually 
all sources that will be encountered and should rarely, if ever, 
require adjustment.  For additional details, in Chapter 4 refer 
to the “Input Menu Functions” section on page 30. 
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6. Press {AR} to access the Aspect Ratio Menu.  

a. Scroll to the Mode line and select 16:9, 5:4, 4:3, 3:2, 1:1 or Custom 
aspect ratios.

b. If Custom is selected, scroll to the Ratio line and enter a custom aspect 
ratio as desired.  

c. Press {SAVE} to save the selected input in the designated file.

d. Press {BACK} to return to the Input Menu.

7. When all of your adjustments are complete, press {CFG} to display the Input 
Configuration Menu.  

a. Press {SAVE} to save the selected input in the designated input file.  All 
information is stored in non-volatile flash memory.

b. If required, press {DELETE} to delete the file. 

c. Press {BACK} to return to the Input Menu.

8. To set up the next input, repeat the entire procedure from step 2.

Please continue with the “Setting up the Background” section on page 93.

Important If you have not already performed incremental “saves,” 
ensure that you save the input configuration before you exit 
the Input Menu — otherwise all of your adjustments will be 
lost.  Because each input has its own file, if you do not save 
the input, the next time the source is selected, the input’s 
default settings will be displayed.

Note In the current version of PresentationPRO-II, the file number 
and name (into which you will save data) automatically default 
to the input number and cannot be changed.
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Setting up the Background
pÉííáåÖ=ìé=íÜÉ=_~ÅâÖêçìåÇ
With PresentationPRO-II, you can use the DVI input, a matte color, or a still frame as the 
background source.  Please note:

• The system has one DVI connector (BG/DSK) that can be used for either the 
Background or the DSK — but not both simultaneously.  

• The BG/DSK input (along with a scaled PIP image) is the source of still frames 
that can be captured and used as the background.

• The function of the BG/DSK input is determined by the “Mode” line on the BG/
DSK Input Setup Menu.  When set to BG, the background setup procedures 
outlined below apply.

Select the procedure below for the type of background that you wish to set up:

• Programming EDID

• Using a Matte Color as the Background

• Using the DVI Input as the Background

• Using a Still Frame as the Background

mêçÖê~ããáåÖ=bafa
The EDID (Extended Display Identification Data) programming procedure is a prerequisite 
for using a live DVI background or for using the DSK.  The procedure guarantees proper 
communications at the preferred resolution between PresentationPRO-II’s DVI input and 
your external computer. 

Use the following steps to program the PresentationPRO-II EDID:

1. Ensure that the PresentationPRO-II output format matches your projector’s native 
resolution.  Refer to the “Output Setup” section on page 88 for instructions.

2. Ensure that the computer (or external equipment) that you wish to use as a 
background source is capable of supporting the selected output resolution.

3. From the HOME MENU, press {SYSTEM} > {EDID} to display the EDID DVI Input 
Format Menu.

4. Note the Current line, which displays the current EDID video format that resides 
in PresentationPRO-II memory.  If this format is already set to the desired 
resolution, no EDID programming is required.  You can exit this procedure, and 
continue with other background setup steps as needed.

5. If a new resolution is required, use the ADJ knob to adjust the Format to the 
preferred setting at which you want to program the EDID.  

6. Press {PROGRAM EDID} to program EDID with the new selected video format.  A 
warning message will be shown.  Press {YES} to continue.

7. Once EDID programming is complete on PresentationPRO-II, power down the 
external computer and power it back on.  

8. On your PC’s desktop, right-click to display the Display Properties Window.  

9. Select the Settings Tab, and set the resolution to match that which you just 
programmed into EDID.  
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rëáåÖ=~=j~ííÉ=`çäçê=~ë=íÜÉ=_~ÅâÖêçìåÇ
This procedure enables you to set up the background as a matte color that can be used 
behind a PIP or Key.  

Use the following steps to set up a solid matte color as a background source:

1. (Optional) To ensure that the full background is visible, clear any PIP, Key or 
LOGO from Program. 

2. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.   

3. Scroll to the Mode line and select BG.    

4. Scroll to the Type line and select MATTE.    

5. Press {MATTE} to display the Background Matte Menu.  

6. Adjust the Red, Green and Blue values as desired.  At this point, the selected 
color is the new background that you can use behind PIPs and Keys.

7. Press {BACK} to return to the BG/DSK Input Setup Menu.

8. Press {SAVE} to save the background input configuration.

rëáåÖ=íÜÉ=asf=fåéìí=~ë=íÜÉ=_~ÅâÖêçìåÇ
This procedure enables you to set up the DVI source as the background layer.  The DVI 
source originates from an external computer or other external device.  

It is recommended that you perform these steps as a setup procedure.  However, once the 
DVI input is set, during live production you can switch the background between a Matte 
color, a still frame and a DVI source.

Please remember that the BG/DSK input is shared between BG and DSK.  If you elect to 
use a live DVI input as the background, it cannot be used as the DSK simultaneously.  

Use the following steps to set up a DVI input as a background:

1. (Optional) To ensure that the full background is visible, clear any PIP, Key, or 
LOGO from Program. 

2. Ensure that the PresentationPRO-II EDID is properly programmed.  Refer to the 
“Programming EDID” section on page 93 for instructions.

3. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.

4. Scroll to the Mode line and select BG.    

5. Scroll to the Type line and select DVI.    

6. If required, press {FORCE ACQUIRE} to force the system to perform the optimum 
setup on the DVI input.  If the operation is successful, Format and Type should 
correctly reflect the characteristics of the incoming signal.

7. If required, scroll to the Format line and manually set the resolution of the 
incoming source.  In Appendix A, refer to the “Input and Output Resolutions“ 
section on page 129 for details on all available resolutions.

8. If you manually selected a format in the previous step, press {SELECT FORMAT} 
to “accept” and activate the selection.  
94 PresentationPRO-II  •  User’s Guide

Download from Www.Somanuals.com. All Manuals Search And Download.



5.  System Setup
Setting up the Background
9. For the two Crop settings:

~ If the input resolution matches the output resolution, or if the output 
resolution is larger than the input resolution, the Crop settings will be 
bracketed.  

~ If the input resolution is larger than the output resolution, adjust the H 
Offset and V Offset values to choose which portion of the input you want 
to display.  

~ If required, press {RESET} to reset the H and V offsets to 0.  

10. Press {SAVE} to save the background input configuration.

rëáåÖ=~=píáää=cê~ãÉ=~ë=íÜÉ=_~ÅâÖêçìåÇ
This procedure enables you to capture a still frame image and assign it as the background 
“type.”  Please note:

• As a recommendation, capture still frames into “temporary” memory as a setup 
procedure.  

• Once still frames are captured, during live production you can easily switch the 
background between Matte, a DVI input and a still frame.  

Use the following steps to assign a captured still frame as the background “type.”

1. Because the background input is the source of the still frames which you will 
capture, ensure that the background input is properly set up as a DVI source.  
Refer to the “Using the DVI Input as the Background” section on page 94 for 
setup details.

2. In Chapter 6, refer to the “Capturing Still Frames” section on page 117 for 
instructions on capturing still frames.  Up to three frames can be captured into 
temporary memory: FG_1, FG_2 and FG_3.

3. In the Layer Functions Section, press BG/DSK.  The button will blink and the 
BG/DSK Input Setup Menu will appear.  

4. Scroll to the Mode line and select BG. 

5. Scroll to the Type line and select the desired still frame (FG_1, FG_2 and FG_3).

Important It is highly recommended that you save still frames into 
“permanent” flash memory as a setup procedure — as this is 
a very time-consuming step that locks the front panel of 
PresentationPRO-II.
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pÉííáåÖ=ìé=íÜÉ=aph
With PresentationPRO-II, you can use the DVI input or a still frame as the DSK source.  
You can also change which source you use for the DSK during the course of a live 
production — provided that the DSK has been properly set up.  

Select the procedure below for the type of DSK that you wish to set up:

• Using the DVI Input as the DSK

• Using a Still Frame as the DSK

rëáåÖ=íÜÉ=asf=fåéìí=~ë=íÜÉ=aph
This procedure enables you to set up the DVI source as the DSK’s input type.  It is 
recommended that you perform these steps as a setup procedure.  However, once the 
DSK is set up, during live production you can switch it between a captured still frame and 
the DVI source.  

Use the following steps to set up the DVI input as your DSK source:

1. Ensure that the PresentationPRO-II EDID is properly programmed.  Refer to the 
“Programming EDID” section on page 93 for instructions.

2. If you have not already set up the BG/DSK input as a DVI source, follow the setup 
procedure as outlined in the “Using the DVI Input as the Background” section 
on page 94.  

3. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.  

4. Scroll to the Mode line and select DSK. 

5. Scroll to the Type line and select DVI.

6. Press {KEY} to display the DSK Adjustment Menu.

7. Adjust key parameters as required.  In Chapter 4, refer to the “DSK Adjustment 
Menu” section on page 78 for details.  

Note Remember that the BG/DSK input is shared between BG and 
DSK.  If you elect to use a “live” DVI input as the background, 
it cannot be used as the DSK simultaneously.
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This procedure enables you to capture a still frame image and assign it as the “type” for the 
DSK.  Please note:

• As a recommendation, capture still frames into “temporary” memory as a setup 
procedure.  

• Once still frames are captured, during live production you can switch the DSK 
between the DVI input and a Still Frame.  

Use the following steps to assign a captured still frame as the DSK “type.”

1. Ensure that BG/DSK input is properly set up as a DVI source.  This input is the 
source of the still frames which you will capture.  Refer to the “Using the DVI 
Input as the Background” section on page 94 for setup details.

2. In Chapter 6, refer to the “Capturing Still Frames” section on page 117 for 
instructions on capturing still frames.  Up to three frames can be captured into 
temporary memory: FG_1, FG_2 and FG_3.

3. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.  

4. Scroll to the Mode line and select DSK. 

5. Scroll to the Type line and select the desired still frame: FG_1, FG_2 or FG_3.

Important It is highly recommended that you save still frames into 
“permanent” flash memory as a setup procedure — as this is 
a very time-consuming step that locks the front panel of 
PresentationPRO-II.
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pÉííáåÖ=ìé=íÜÉ=ildl
With PresentationPRO-II, you can set the LOGO source as a captured still frame, or leave 
it as Black (the default setting upon factory reset).  You can also change which source you 
use during live production.

Use the following steps to set up the LOGO source:

1. Ensure that the background input is properly set up as a DVI source.  This input 
(along with scaled PIP images) is the source of still frames that you can capture.  
Refer to the “Using the DVI Input as the Background” section on page 94 for 
setup details.

2. In Chapter 6, refer to the “Capturing Still Frames” section on page 117 for 
instructions on capturing still frames.  Up to three frames can be captured: FG_1, 
FG_2 and FG_3.

3. In the Layer Functions Section, press the LOGO button.  The button blinks and 
the LOGO Input Setup Menu appears.   

4. On the Type line, select the desired still frame (FG_1, FG_2 or FG_3), or select 
Black.    

Please continue with the “Saving the Setup” section on page 98.

p~îáåÖ=íÜÉ=pÉíìé
When all system setup procedures have been completed:

1. From the Home Menu press {SYSTEM} to display the System Menu.  

2. Press {SAVE} to save all settings in the system file.

Once pressed, the Touch Screen menu reads “Saving System Configuration.”  This step 
ensures that when you cycle power, the PresentationPRO-II returns to the state in which it 
was configured at the time of the “save.”

Note Because the LOGO is the highest priority layer and 
downstream of all other effects, the “black” source can serve 
as a convenient way to fade all effects to black.
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få=qÜáë=`Ü~éíÉê
This chapter includes operational instructions for all PresentationPRO-II modes and 
functions.  The following topics are discussed:

• Prerequisites

• Operational Configuration

• Working with Layers

• Working with Layer Functions

• Working with Transitions

• Using Remote Control

• Capturing Still Frames

Note When a sequence of menu selections is required to complete 
a given procedure, the ">" symbol is used to divide each 
successive menu pick.  

Example:  To access the Sizing Menu, press 
{HOME} > {INPUT} > {SIZING}.
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Prerequisites
mêÉêÉèìáëáíÉë
Prior to using the PresentationPRO-II system in a live event, please ensure the following:

• All system inputs, background (or DSK) and the LOGO are properly configured.  
In Chapter 5, refer to the following sections for details:

~ “Comprehensive Input Setup“ on page 90.

~ “Setting up the Background“ on page 93.

~ “Setting up the DSK“ on page 96.

~ “Setting up the LOGO“ on page 98.

• Ensure that you are familiar with all front panel controls.  In Chapter 2, refer to the 
“PresentationPRO-II Front Panel“ section on page 15 for details. 

• Ensure that you are familiar with all system menus, and in particular, the 
operational menus.  In Chapter 4, refer to the following sections for details:

~ Refer to the “PIP Adjustment Menu“ section on page 57 for details on 
all PIP adjustments.

~ Refer to the “Key Menu“ section on page 65 for details on all Key 
adjustments.

~ Refer to the “Input Source Adjustment Menu“ section on page 71 for 
details on all input source adjustments.  

Tip As you review each function in this chapter, it is 
recommended that you try out each mode and feature at the 
PresentationPRO-II panel itself — using a fully configured 
system consisting of a projector, Program monitor, and all the 
necessary sources. 
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Operational Configuration
léÉê~íáçå~ä=`çåÑáÖìê~íáçå
The following topics are discussed in this section:

• Monitor Layout

• Touch Screen Calibration

• A Word About LOS

jçåáíçê=i~óçìí
Use the following diagram as a recommended layout for your monitor.  

Figure 6-1.  Application Layout

For optimum viewing and utility, place your Program monitor in close proximity to the 
chassis, either above or immediately to the right.

qçìÅÜ=pÅêÉÉå=`~äáÄê~íáçå
As an excellent prerequisite to all operating procedures, it is recommended that you 
calibrate the Touch Screen.

Use the following steps to calibrate your Touch Screen display:

1. If required, press {HOME} to display the Home Menu.

2. Press {DISPLAY} to show the Display Settings Menu.

3. Press {LCD CAL} to display the first Touch Screen Calibration Menu.  

4. Follow directions on screen to complete the calibration procedure. 

^=tçêÇ=^Äçìí=ilp
On rare occasion, you can experience LOS (loss of signal) — typically due to a poor video 
or computer connection.  In these cases, PresentationPRO-II obeys a precise set of rules:

• Scaler LOS — If there is a LOS for a video signal inside a scaler (PIP or KEY), 
the video switches to black, but the scaler remains in its current size and position.  

• Background LOS — If there is a LOS for the background DVI input, the video 
switches to the background’s selected matte color.    

• DSK LOS — If there is a LOS for the DSK, the system switches the DSK Off 
(specifically, selecting "none" as the type).    

In each case, when the video signal recovers, the system re-enables it as before.

Program
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Working with Layers
tçêâáåÖ=ïáíÜ=i~óÉêë
The following topics are discussed in this section:

• Working with PIPs

• Modifying PIPs

• Working with Keys

• Modifying Keys and DSKs

• Background and DSK Transitions

• LOGO Transitions

tçêâáåÖ=ïáíÜ=mfmë

With PresentationPRO-II, you can perform the following types of PIP transitions:

• Transitioning a PIP to Program

• Removing a PIP from Program

• Cancelling a PIP Transition

• Changing a PIP to a KEY

qê~åëáíáçåáåÖ=~=mfm=íç=mêçÖê~ã
Use the following steps to transition a PIP to Program:  

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, ensure that the PIP button is blinking.  If not, 
press PIP to display the PIP Adjustment Menu.  Please note:

~ If there is no source on Program, the last source associated with the PIP 
will blink on the Source Selection Bus. 

~ If there is a source currently on Program, it will be lit solid on the Source 
Selection Bus. 

3. On the Source Selection Bus, select a new source.  The button blinks to indicate 
that the source is "pending."  

~ If there is no source on Program, only the pending source will blink.

~ If there is a source currently on Program, the pending source will blink 
and the current source will be lit solid.  

4. In the Layer Functions Section, press TRANS.  The current PIP transitions off, 
the new PIP transitions on, and the TRANS button lights during the interval.  

PIP

Tip From this point forward, transitioning a PIP is a simple two-
button sequence:  (1) select source, (2) press TRANS.
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5. Adjust the PIP’s size, position, border, shadow, source image, cropping and 
"special effects" as desired.  Refer to the “Modifying PIPs“ section on page 104.  

oÉãçîáåÖ=~=mfm=Ñêçã=mêçÖê~ã

Use the following steps to remove a PIP from Program:

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, ensure that the PIP button is blinking.  If not, 
press PIP to display the PIP Adjustment Menu.  On the Source Selection Bus, 
the source associated with the PIP will be lit solid.  

3. In the Layer Functions Section, press CLEAR to "pend" the removal of the PIP.  
The CLEAR button will blink to indicate that the operation is pending. 

4. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.

`~åÅÉääáåÖ=~=mfm=qê~åëáíáçå
Use the following steps to cancel a PIP transition.  

Assumption:  A PIP transition has been selected, and the PIP button is 
blinking.

1. In the Layer Functions Section, press PIP.  The button stops blinking, and the 
pending transition is cancelled.  Please note:

~ If there is no source currently on Program, the PIP button turns off.

~ If there is a source currently on Program, the PIP button stops blinking 
but remains lit.    

`Ü~åÖáåÖ=~=mfm=íç=~=hbv
Use the following steps to change a PIP to a Key.  

Assumption:  A PIP is currently on Program.

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, press KEY.  Please note:

~ The KEY button blinks and the PIP button remains lit solid.

~ The Key Menu appears, and the source associated with the PIP lights 
solid on the Source Selection Bus.

3. If desired, select a new key source on the Source Selection Bus.  The pending 
source blinks and the current PIP source remains lit solid.  

Tip Ensure that you establish the PIP’s initial size and position 
before your live event begins.

CLEAR

Note If you do not select a new source, the current source will be 
used.  It will transition off as a PIP, and back on as a Key.
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4. In the Layer Functions Section, press TRANS.  The current PIP transitions off 
and the new KEY transitions on.   The TRANS button lights during the interval.

5. Adjust the Key’s clip, gain, mode, opacity, fill source, size and position, crop, 
source size and special effects desired.  Refer to the “Modifying Keys and 
DSKs“ section on page 107 for details.

jçÇáÑóáåÖ=mfmë
Use the following steps to modify a PIP:  

Assumption:  A PIP is currently on Program.

1. In the Layer Functions Section, ensure that the PIP button is blinking.  If not, 
press PIP to display the PIP Adjustment Menu.  On the Source Selection Bus, 
the source associated with the PIP will be solid.  

2. Size and Position — Adjust H Size, V Size, H Position and V Position as 
desired.  In Chapter 4, refer to the "PIP Adjustment Menu Description" section 
on page 58 for menu details. 

3. Source Size — From the PIP Adjustment Menu, press {SRC} to display the 
Input Source Adjustment Menu.  Use the menu to adjust the source image’s 
size and position within the PIP.  In Chapter 4, refer to the "Input Source 
Adjustment Menu Description" section on page 72 for menu details. 

4. Crop — From the PIP Adjustment Menu, press {CROP} to display the Crop 
Adjustment Menu.  Use the menu to select the type of crop, the aspect ratio, and 
the image’s H and V size.  In Chapter 4, refer to the "Crop Menu" section on 
page 61 for menu details.    

5. Border — From the PIP Adjustment Menu, press {BORDER} to display the 
Border Menu.  Use the menu to select the border’s style, color and size.  In 
Chapter 4, refer to the "Border Menu" section on page 60 for menu details.   

6. Shadow — From the Border Menu, press {SHADOW} to display the Shadow 
Menu.  Use the menu to choose the shadow’s size, position and transparency.  In 
Chapter 4, refer to the "Shadow Menu" section on page 62 for menu details.

7. Special Effects — From the Border Menu, press {EFX} to display the Image 
Effects Menu.  Use the menu to select monochrome or color mode, to modify 
chroma and hue, to invert the color, and to set a strobe effect.  In Chapter 4, refer 
to the "Image Effects Menu" section on page 63 for menu details.

8. Global Functions — Remember that the following global functions are always 
available to you:

~ Press Reset to reset the current effect (e.g., PIP, Key, crop, etc.) to a 
nominal default value.

~ Press Full Screen to bring the PIP to full screen, using the source’s 
height as the defining factor.  

~ Press Freeze to freeze the PIP.  Press again to unfreeze.

Note Because the PIP is on Program, it is recommended that you 
make slow, smooth adjustments during a live production. 
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tçêâáåÖ=ïáíÜ=hÉóë

With PresentationPRO-II, you can perform the following types of Key transitions:

• Transitioning a Key to Program

• Removing a Key from Program

• Cancelling a Key Transition

• Changing a KEY to a PIP

qê~åëáíáçåáåÖ=~=hÉó=íç=mêçÖê~ã
Use the following steps to transition a Key to Program:  

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, ensure that the KEY button is blinking.  If not, 
press KEY to display the Key Adjustment Menu.  Please note:

~ If there is no source on Program, the last source associated with the Key 
will blink on the Source Selection Bus. 

~ If there is a key source currently on Program, it will be lit solid on the 
Source Selection Bus. 

3. On the Source Selection Bus, select a new key source.  The button blinks to 
indicate that the source is "pending."  

~ If there is no source on Program, only the pending source will blink.

~ If there is a source currently on Program, the pending source will blink 
and the current source will be lit solid.  

4. In the Layer Functions Section, press TRANS.  The current Key transitions off, 
the new Key transitions on, and the TRANS button lights during the interval.  

5. Adjust the Key’s clip, gain, mode, opacity, fill source, size and position, crop, 
source size and special effects desired.  Refer to the “Modifying Keys and 
DSKs“ section on page 107 for details.  

KEY

Tip From this point forward, transitioning a Key is a simple two-
button sequence:  (1) select key source, (2) press TRANS.

Tip Ensure that you establish the Key’s initial clip, gain and 
opacity parameters before your live event begins.
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oÉãçîáåÖ=~=hÉó=Ñêçã=mêçÖê~ã

Use the following steps to remove a Key from Program:

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, ensure that the KEY button is blinking.  If not, 
press Key to display the Key Adjustment Menu.  On the Source Selection Bus, 
the source associated with the Key will be lit solid.  

3. In the Layer Functions Section, press CLEAR to "pend" the removal of the Key.  
The CLEAR button will blink to indicate that the operation is pending. 

4. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.

`~åÅÉääáåÖ=~=hÉó=qê~åëáíáçå
Use the following steps to cancel a Key transition.  

Assumption:  A Key transition has been selected, and the KEY button is 
blinking.

1. In the Layer Functions Section, press KEY.  The button stops blinking, and the 
pending transition is cancelled.  Please note:

~ If there is no source currently on Program, the KEY button turns off.

~ If there is a source currently on Program, the KEY button stops blinking 
but remains lit.    

`Ü~åÖáåÖ=~=hbv=íç=~=mfm
Use the following steps to change a Key to a PIP.  

Assumption:  A Key is currently on Program.

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, press PIP.  Please note:

~ The PIP button blinks and the KEY button remains lit solid.

~ The PIP Adjustment Menu appears, and the source associated with the 
Key lights solid on the Source Selection Bus.

3. If desired, select a new PIP source on the Source Selection Bus.  The pending 
source blinks and the current Key source remains lit solid.  

4. In the Layer Functions Section, press TRANS.  The current Key transitions off 
and the new PIP transitions on.  The TRANS button lights during the interval.

5. Adjust the new PIP’s size, position, border, shadow, source image, cropping and 
"special effects" as desired.  Refer to the “Modifying PIPs“ section on page 104 
for details.

CLEAR

Note If you do not select a new source, the current source will be 
used.  It will transition off as a Key, and back on as a PIP.
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Use the following steps to modify a Key or DSK: 

Assumption:  A Key (or DSK) is currently on Program.

1. Use one of two methods to access the key adjustment menus:

~ For a Key — In the Layer Functions Section, press KEY to activate the 
current Key for modification.  The Key Menu appears.

~ For a DSK — Press BG/DSK to display the BG/DSK Input Setup Menu 
appears.  Then press {KEY} to display the DSK Adjustment Menu.

2. Clip, Gain, Mode, Opacity — Use the controls to adjust clip, gain, invert mode 
and opacity.  In Chapter 4:

~ Refer to the "Key Menu Description" section on page 66.

~ Refer to the "DSK Adjustment Menu" section on page 78. 

3. Fill Source — Use the controls in the Key Menu to select a self or matte fill key.  
If Matte is selected, press {MATTE} to display the Matte Menu, with which you 
can choose the matte fill color.   In Chapter 4, refer to the "Matte Menu" section 
on page 68 for menu details.

For a Key only:

4. Size and Position — From the Key Menu, press {SIZE & POS} to display the 
Key Adjustment Menu.  Use the controls to size and position the Key.  In 
Chapter 4, see the "Key Adjustment Menu" section on page 69 for menu details.

5. Crop — From the Key Menu, press {CROP} to display the Crop Adjustment 
Menu.  Use the menu to select the type of crop, the aspect ratio, and the image’s 
H and V size.  In Chapter 4, refer to the "Crop Menu" section on page 61 for 
menu details.    

6. Source Size — From the Crop Menu, press {SRC} to display the Key Source 
Adjustment Menu.  Use the menu to adjust the source image’s size and position 
within the PIP.  In Chapter 4, refer to the "Input Source Adjustment Menu 
Description" section on page 72 for menu details. 

7. Special Effects — From the Matte Menu, press {EFX} to display the Image 
Effects Menu.  Use the menu to select monochrome or color mode, to modify 
chroma and hue, to invert the color, and to set a strobe effect.  In Chapter 4, refer 
to the "Image Effects Menu" section on page 63 for menu details.

8. Global Functions — Remember that the following global functions are always 
available to you:

~ Press Reset to reset the current effect to a default value.

~ (For a Key only) Press Full Screen to bring the Key to full screen, using 
the source’s height as the defining factor.  

~ Press Freeze to freeze the Key.  Press again to unfreeze.

For a Key and a DSK:

9. Transition — Transition the new "look" to program with a MIX or WIPE.  Refer to 
the “Working with Transitions“ section on page 115 for details.

Note Because the Key is on Program, it is recommended that you 
make slow, smooth adjustments during a live production. 
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With PresentationPRO-II, you can perform the following types of background and DSK 
transitions:

• Setting the Background Mode

• Transitioning to a Matte Color

• Transitioning to a Live DVI Background

• Transitioning to a Still Frame

• Keying the DVI source in DSK Mode

• Keying a Still Frame in DSK Mode

• Changing Background Matte Colors in DSK Mode

• Cancelling a Background or DSK Transition

• Clearing a Background or DSK

pÉííáåÖ=íÜÉ=_~ÅâÖêçìåÇ=jçÇÉ

Use the following steps to set the background mode:

1. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.  

2. On the Mode line, set the desired mode:

~ To work in background mode, select BG.  This enables you to use a color 
matte, a still frame, or a live DVI source as the background layer.

~ To work in DSK mode, select DSK.  This enables you to use a still frame 
or a live DVI source as the downstream key.  You can also set a 
background matte color, which will appear under a PIP or Key.   

BG/DSK

Tip Ensure that you set the background mode before your live 
event begins.

Note The PresentationPRO-II system enables you to switch 
seamlessly between BG and DSK modes during a live event.  
Remember, though, that any pending background (or DSK) 
will not be seen until it transitions to Program, so it is to your 
advantage to preset your background colors, DVI sources, 
key clips, etc. 
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qê~åëáíáçåáåÖ=íç=~=j~ííÉ=`çäçê
The PresentationPRO-II system enables you to transition from any BG or DSK mode to a 
matte color — or from a matte color to another matte color.

Use the following steps to transition to a background matte color:

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.  

3. On the Mode line, select BG — or simply verify that it is already selected.

4. Scroll to the Type line and select Matte.  The current background will not change.

5. If you wish to set (or change) the background matte color:

~ Press {MATTE} to display the Matte Menu.  

~ On the menu, adjust the Red, Green and Blue matte values as desired.  
You will not see the colors change on Program.

6. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.

qê~åëáíáçåáåÖ=íç=~=iáîÉ=asf=_~ÅâÖêçìåÇ=
The PresentationPRO-II system enables you to transition from any BG or DSK mode to a 
live DVI background.

Use the following steps to transition to a live DVI background:  

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. Ensure that your DVI background is properly set up.  In Chapter 5, refer to the 
“Setting up the Background“ section on page 93 for details.

3. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.

4. On the Mode line, select BG — or simply verify that it is already selected. 

5. Scroll to the Type line and select DVI.  The current background will not change.

6. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.

qê~åëáíáçåáåÖ=íç=~=píáää=cê~ãÉ
The PresentationPRO-II system enables you to transition from any BG or DSK mode to a 
still frame background — or from a still frame to another still frame.

Use the following steps to transition a still frame to Program:  

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. Ensure that the desired still frames have been captured.  Refer to the “Still Frame 
Capture Overview“ section on page 117 for details.

3. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.

4. On the Mode line, select BG — or simply verify that it is already selected.
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5. Scroll to the Type line and select FG_1, FG_2 or FG_3.  The current background 
will not change.

6. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.

hÉóáåÖ=íÜÉ=asf=ëçìêÅÉ=áå=aph=jçÇÉ
The PresentationPRO-II system enables you to transition from any BG or DSK mode to a 
DSK — using the DVI input as the key source.

Use the following steps to key the live DVI source in DSK mode:

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. Ensure that your DVI background is properly set up.  In Chapter 5, refer to the 
“Setting up the Background“ section on page 93 for details.

3. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.

4. On the Mode line, select DSK — or simply verify that it is already selected.

5. Scroll to the Type line and select DVI.  The current background will not change.

6. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the, and at the conclusion of the transition, the Home Menu appears.  

7. Modify the DSK as required.  Refer to the "Modifying Keys and DSKs" section 
on page 107 for details.   

hÉóáåÖ=~=píáää=cê~ãÉ=áå=aph=jçÇÉ
The PresentationPRO-II system enables you to transition from any BG or DSK mode to a 
DSK — using a still frame as the key source.  You can also change from one still frame to 
another still frame.

Use the following steps to key a still frame in DSK mode:

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. Ensure that the desired still frames have been captured.  Refer to the “Still Frame 
Capture Overview“ section on page 117 for details.

3. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.

4. On the Mode line, select DSK — or simply verify that it is already selected.

5. Scroll to the Type line and select FG_1, FG_2 or FG_3.  

Tip Ensure that you establish the Downstream Key’s initial clip, 
gain and opacity parameters before your live event begins.

Important When you key the DVI source in DSK mode and your PIP is 
not full screen, the background matte is visible as the bottom 
layer in the effect — behind the PIP.  Refer to the "Changing 
Background Matte Colors in DSK Mode" section on 
page 111 for details on changing the matte color.
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6. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.  

7. Modify the DSK as required.  Refer to the "Modifying Keys and DSKs" section 
on page 107 for details.   

`Ü~åÖáåÖ=_~ÅâÖêçìåÇ=j~ííÉ=`çäçêë=áå=aph=jçÇÉ
The PresentationPRO-II system enables you to change the background matte color while 
the system is in DSK mode.    

Use the following steps to set the background matte color in DSK mode:

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.

3. Press {BG MATTE} to display the Background Matte Menu.

4. On the menu, adjust the Red, Green and Blue matte values as desired.  You will 
not see the color change on Program.

5. In the Layer Functions Section, press TRANS to change the background matte 
color.  The TRANS button lights during the interval, and at the conclusion of the 
transition, the Home Menu appears.

`~åÅÉääáåÖ=~=_~ÅâÖêçìåÇ=çê=aph=qê~åëáíáçå
Use the following steps to cancel a background or DSK transition.  

Assumptions:  A background or DSK transition has been selected, and the 
BG/DSK button is blinking.

1. In the Layer Functions Section, press BG/DSK.  The button stops blinking, the 
pending transition is cancelled, and the Home Menu is displayed.  

`äÉ~êáåÖ=~=_~ÅâÖêçìåÇ=çê=aph
The PresentationPRO-II system enables you to clear any BG or DSK from Program — 
back to the current background matte color.  Note that a background matte color itself 
cannot be cleared from Program.  However, you can change its color:

• If you’re working in BG mode, refer to the "Transitioning to a Matte Color" 
section on page 109 for details.

• If you’re working in DSK mode, refer to the "Changing Background Matte 
Colors in DSK Mode" section on page 111 for details.    

Tip Ensure that you establish the Downstream Key’s initial clip, 
gain and opacity parameters before your live event begins.

Important When you key a still frame in DSK mode and your PIP is not 
full screen, the background matte is visible as the bottom 
layer in the effect — behind the PIP.  Refer to the "Changing 
Background Matte Colors in DSK Mode" section on 
page 111 for details on changing the matte color.
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Use the following steps to clear the background or the DSK from Program.   

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, press BG/DSK.  The button blinks and the BG/
DSK Input Setup Menu appears.

3. In the Layer Functions Section, press CLEAR to "pend" the removal of the 
background or DSK.  The CLEAR button will blink. 

4. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.  

Please note:

• If you’re working in BG mode, at the conclusion of the transition, the background 
Type will automatically change to Matte.

• If you’re working in DSK mode, at the conclusion of the transition, the background 
Type will not change.

CLEAR
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With PresentationPRO-II, you can perform the following types of LOGO transitions:

• Transitioning the LOGO to Program

• Clearing the LOGO from Program

qê~åëáíáçåáåÖ=íÜÉ=ildl=íç=mêçÖê~ã
Using the LOGO source, you can transition a captured still frame to Program at the highest 
priority layer — covering all effects underneath.  

Use the following steps to transition the LOGO to Program:  

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. Ensure that the desired still frames have been captured.  Refer to the “Still Frame 
Capture Overview“ section on page 117 for details.

3. In the Layer Functions Section, press LOGO.  The button blinks and the LOGO 
Input Setup Menu appears.

4. Scroll to the Type line and select FG_1, FG_2, FG_3 or Black. 

5. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.

`äÉ~êáåÖ=íÜÉ=ildl=Ñêçã=mêçÖê~ã
Use the following steps to clear the LOGO from Program:  

1. Ensure that you have preset the desired transition type and rate.  Refer to the 
"Working with Transitions" section on page 115 for details.

2. In the Layer Functions Section, press TRANS.  The TRANS button lights during 
the interval, and at the conclusion of the transition, the Home Menu appears.  
This simple shortcut works because the LOGO is the only layer visible on 
Program, and thus the only element that can transition off.

LOGO

Tip In addition to its use as a full screen downstream graphic, the 
LOGO can also be used as a convenient “black preview” 
function.  When the LOGO source is set to Black, you can 
fade to black at any time, from any simple or complex setup, 
without affecting the underlying "look."

Note If desired, you can also clear the LOGO by pressing LOGO, 
CLEAR, TRANS.
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tçêâáåÖ=ïáíÜ=i~óÉê=cìåÅíáçåë
The following topics are discussed in this section: 

• Using Full Screen

• Using Freeze

• Using Reset

rëáåÖ=cìää=pÅêÉÉå

Use the following steps to take the active PIP or Key to full screen:

1. In the Layer Functions Section, press PIP or KEY as required.  The button 
blinks, and the associated source blinks on the Source Selection Bus.

2. In the Layer Functions Section, press Full Screen.  The source’s height will be 
used as the parameter that define’s the full screen size.  If borders are ON, they 
will be taken into account so that they are visible.

rëáåÖ=cêÉÉòÉ

Use the following steps to freeze a PIP or KEY on Program.  This function is useful for 
PIPs and Keys that use video and animated graphics.

1. In the Layer Functions Section, press PIP or KEY as required.  The button 
blinks, and the associated source blinks on the Source Selection Bus.

2. In the Layer Functions Section, press FREEZE.  The button lights solid to 
indicate that a “freeze” is associated with the current PIP or Key.  

3. To restore motion to the source, ensure that PIP or KEY is selected (and blinking), 
then press FREEZE.   

rëáåÖ=oÉëÉí

The Reset function is context sensitive.  It is used to reset the current effect to a nominal 
default value.   

Use the following steps to reset a specific PIP or Key modification parameter:

1. In the Layer Functions Section, press PIP or KEY as required.  The button 
blinks, and the associated source blinks on the Source Selection Bus.

2. Ensure that FREEZE is off.  Frozen PIPs or Keys cannot be reset. 

3. If required, navigate to the "menu" whose specific function you want to reset (e.g., 
borders, shadows, special effects, size, etc).    

4. In the Layer Functions Section, press RESET to reset the current effect.  

FULL
SCREEN

FREEZE

RESET
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6.  Operations
Working with Transitions
tçêâáåÖ=ïáíÜ=qê~åëáíáçåë
Use the following steps to perform a Mix (or "dissolve"):

1. Set up the desired PIP, Key, BG, DSK or LOGO transition in the normal manner.  

2. Preset the desired transition rate:  

a. Press {HOME} > {EFFECTS} to display the Effects Menu.

b. Scroll to the Transition Type line and select MIX.

c. Scroll to the Transition Rate line and select the desired rate, in 0.1 
second increments.

3. In the Transition Section, press TRANS to dissolve the setup to Program.  At the 
conclusion of the transition, the Home Menu appears

Use the following steps to perform a Wipe:

1. Set up the desired PIP, Key, BG, DSK or LOGO transition in the normal manner.  

2. Preset the desired transition rate, wipe effect and wipe edge:  

a. Press {HOME} > {EFFECTS} to display the Effects Menu.

b. Scroll to the Transition Type line and select the desired wipe pattern.

c. Scroll to the Transition Edge field and select the desired wipe edge.

d. Scroll to the Transition Rate line and select the desired rate, in 0.1 
second increments.

3. In the Transition Section, press TRANS to wipe the setup to Program.  At the 
conclusion of the transition, the Home Menu appears

TRANS
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6.  Operations
Using Remote Control
rëáåÖ=oÉãçíÉ=`çåíêçä
When PresentationPRO-II is controlled from an external controller, the Remote Control 
Menu is used to set the unit ID and enable/disable remote control itself.  Please note the 
following prerequisites:

• Ensure that you know the unit IDs currently in use by the external controller.  The 
external controller will not allow PresentationPRO-II to connect if a duplicate ID is 
assigned.

• If an external router is to be connected to PresentationPRO-II, ensure that the 
proper physical connections have been made, and that the router is properly 
configured from the external controller. 

Use the following steps to place PresentationPRO-II under remote control:

1. Press {HOME} > {REMOTE CONTROL} to access the Remote Control Menu.  

2. Set the Unit ID to a value that is not used within the external controller’s system.    

3. Scroll to the Remote Control line turn it ON.  

4. In the “Status” section, verify the following:

~ Connection status with the external controller.

~ Ctrlr IP —  the IP address of the external controller.

~ Destination — the destination assigned to PresentationPRO-II.

~ Router — the utilization of routers, either internal or external.

Use the following steps to reestablish local PresentationPRO-II control:

1. On the Remote Control Menu, scroll to the Remote Control line turn it OFF.  The 
{HOME} buttons reappears, the PresentationPRO-II front panel is re-enabled, and 
all control now originates locally.

Important When remote control is on, the {HOME} buttons disappears, 
the PresentationPRO-II front panel is disabled, and all control 
originates from the external controller.  
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6.  Operations
Capturing Still Frames
`~éíìêáåÖ=píáää=cê~ãÉë
The following topics are discussed in this section:

• Still Frame Capture Overview

• Capturing Still Frames from the Background Input

• Capturing Still Frames from a PIP or Key

• Saving Still Frames in Permanent Memory

píáää=cê~ãÉ=`~éíìêÉ=lîÉêîáÉï
PresentationPRO-II enables you to capture still frames into the system’s three internal 
frame stores.  You can use the system’s DVI input as a full screen source, or within the 
mixer, you can use a PIP or Key as a full screen source.  

Note that within the mixer, all PIP and Key captures must occur on Program, with the 
desired source visible.  However, the system only captures the PIP or Key in its current size 
and position on screen, with no borders and with black as the background.  

Please note the following important prerequisites to all frame grab procedures:

• Ensure that you are familiar with the Background/DSK Input Setup Menu.  In 
Chapter 4, refer to the “Background/DSK Input Setup Menu“ section on 
page 74.

• Ensure that you are familiar with the Frame Grab Menu.  In Chapter 4, refer to the 
“Frame Grab Menu“ section on page 80 for details.

`~éíìêáåÖ=píáää=cê~ãÉë=Ñêçã=íÜÉ=_~ÅâÖêçìåÇ=fåéìí
Use the following steps to capture a still frame from the background DVI input:

1. Ensure that the background input is properly set up as a DVI input.  In Chapter 5, 
refer to the "Using the DVI Input as the Background" section on page 94 for 
instructions.

2. In the Layer Functions Section, press BG/DSK.  The button blinks and the 
Background/DSK Input Setup Menu appears.

3. Scroll to the Mode line and select either BG or DSK.    

4. Scroll to the Type line and select DVI.    

5. Press {FRAME GRAB} to display the Frame Grab Menu.

6. On the FG to Capture line, select the temporary frame store into which the still 
will be captured (FG_1, FG_2 or FG_3). 

7. Press {CAPTURE} to capture the still.  Once pressed, the screen will indicate that 
the frame is being captured.  A pop-up message confirms the procedure.

8. Repeat the procedure from step 6 to capture additional stills from the background 
input.  Remember that you can always overwrite FG_1, FG_2 or FG_3.
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6.  Operations
Capturing Still Frames
Please note:

• The captured still(s) can now be assigned as the input “type” for BG, DSK or 
LOGO.  In Chapter 5, refer to the "Using a Still Frame as the Background" 
section on page 95 for instructions.

• Captured stills reside in temporary memory.  If the system is powered down or 
reset, the stills will be lost.  To save stills in permanent memory, refer to the 
"Saving Still Frames in Permanent Memory" section on page 119.

`~éíìêáåÖ=píáää=cê~ãÉë=Ñêçã=~=mfm=çê=hÉó
Use the following steps to capture a still frame from a PIP or Key:

1. In the Layer Functions Section, press PIP or KEY as required.  The button 
blinks, and the associated source blinks on the Source Selection Bus.

2. Adjust the PIP or Key’s size and position in the normal way.  Remember that the 
system will capture the layer in its current size and position, with no borders — 
and with black as the background.

3. Press {HOME} > {FRAME GRAB} to display the Frame Grab Menu.

4. On the FG to Capture line, select the temporary frame store into which the still 
will be captured (FG_1, FG_2 or FG_3). 

5. Press {CAPTURE} to capture the still.  Once pressed, the screen will indicate that 
the frame is being captured.  A pop-up message confirms the procedure.

6. Repeat the procedure from step 1 to capture additional stills from a layer.  
Remember that you can always overwrite FG_1, FG_2 or FG_3.

Please note:

• The captured still(s) can now be assigned as the input “type” for BG, DSK or 
LOGO.  In Chapter 5, refer to the "Using a Still Frame as the Background" 
section on page 95 for instructions.

• Captured stills reside in temporary memory.  If the system is powered down or 
reset, the stills will be lost.  To save stills in permanent memory, refer to the 
"Saving Still Frames in Permanent Memory" section on page 119.
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6.  Operations
Capturing Still Frames
p~îáåÖ=píáää=cê~ãÉë=áå=mÉêã~åÉåí=jÉãçêó
Use the following steps to save a captured still into permanent memory.  

1. Capture a still as outlined in the previous two sections.  

~ "Capturing Still Frames from the Background Input" on page 117.

~ "Capturing Still Frames from a PIP or Key" on page 118.  

2. On the Frame Grab Menu, press {SAVE} to save the captured frame into the 
selected permanent storage register (FG_1, FG_2 or FG_3).  Once pressed, the 
screen will display an important warning:

Figure 6-2.  Background Frame Save Warning

~ Press YES to save the frame.  All front panel controls will be locked for 
up to three minutes while the still frame is saved.

~ Press NO to cancel the procedure.

3. If required, press {DELETE} to delete the selected frame from permanent storage.  
This button only appears when frames are stored in permanent memory.

Warning Do not execute the next step during live production.  All 
controls will be locked during the "save" process.  It is 
recommended that you save stills during pre-production as a 
"setup" procedure.

System controls will be locked
for 2 to 3 minutes while saving.

Save Now?
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6.  Operations
Capturing Still Frames
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^K==péÉÅáÑáÅ~íáçåë

få=qÜáë=^ééÉåÇáñ
This appendix provides detailed technical specifications for the PresentationPRO-II.  The 
following topics are provided:

• Scaled Video Channel Input Specifications

• Unscaled Background/DSK Input Specifications

• Output Specifications

• User Control

• Physical and Electrical Specifications

• Communications Specifications

• Pinouts 

• Input and Output Resolutions
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^K==péÉÅáÑáÅ~íáçåë
Scaled Video Channel Input Specifications
pÅ~äÉÇ=sáÇÉç=`Ü~ååÉä=fåéìí=péÉÅáÑáÅ~íáçåë=
The table below lists PresentationPRO-II scaled video channel input specifications.

råëÅ~äÉÇ=_~ÅâÖêçìåÇLaph=fåéìí=péÉÅáÑáÅ~íáçåë=
The table below lists PresentationPRO-II unscaled background/DSK input specifications.

Table A-1. PresentationPRO-II Scaled Video Channel Input Specifications

Parameter Specification

Input Types Analog inputs (8) on 15-pin HD connectors

•  RGBHV / RGBS / RGsB computer video 

•  YPbPr video (SD or HD)

•  S-video or composite video

•  On SDI Model, (1) SD-SDI Input on BNC Connector, per SMPTE 
259M-C (NTSC / PAL resolution)

 •  On HD Model, (1) SD-SDI/HD-SDI Input on BNC Connector, per 
SMPTE 259M-C (NTSC / PAL resolution), SMPTE 292M (HDTV)

Input Resolutions •  PAL or NTSC

•  Computer resolutions VGA (640 x 480) through UXGA (1600 x 1200)

•  HDTV resolutions up to 1920 x 1080 (720p, 1080i, 1080p)

•  Plasma display resolutions

Table A-1. PresentationPRO-II Unscaled Background/DSK Input Specifications

Parameter Specification

Input Types DVI Digital Input — per DDWG 1.0 on DVI-I connector

Input Resolutions (Recommendation) Input resolution should be the same as the selected 
output resolution.
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^K==péÉÅáÑáÅ~íáçåë
Output Specifications
lìíéìí=péÉÅáÑáÅ~íáçåë=
The table below lists PresentationPRO-II output specifications.

rëÉê=`çåíêçä=
The table below lists PresentationPRO-II user control specifications.

Table A-2. PresentationPRO-II Output Specifications

Parameter Specification

Analog Output RGBHV / RGBS / RGsB (non-interlaced only) on 15-pin HD connector

Digital Output Digital DVI per DDWG 1.0 on DVI-I connector

Output Resolutions •  Computer resolutions VGA (640 x 480) through UXGA (1600 x 1200)

•  HDTV resolutions, progressive up to 1920 x 1080 (1080p)

•  Plasma display resolutions

Table A-3. PresentationPRO-II User Control Specifications

Parameter Specification

Front Panel Control LCD Touch Screen, rotary encoders and LED lighted push buttons.

Remote Control The unit may be controlled from a computer or external controller via 
LAN, or an RS-232 serial link.
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^K==péÉÅáÑáÅ~íáçåë
Physical and Electrical Specifications
mÜóëáÅ~ä=~åÇ=bäÉÅíêáÅ~ä=péÉÅáÑáÅ~íáçåë=
The table below lists PresentationPRO-II physical and electrical specifications.

`çããìåáÅ~íáçåë=péÉÅáÑáÅ~íáçåë=
The table below lists PresentationPRO-II communications specifications.

Table A-4. PresentationPRO-II Physical and Electrical Specifications

Parameter Specification

Power 120-240 VAC - 50/60 Hz., Auto-selecting 1.0A maximum

Mechanical 2 RU Rackmount Chassis

H: 3.5 inches (8.89 cm)

W: 17.00 inches (43.18 cm) 

D: 15.00 inches (38.10 cm) 

Weight 16.8 lbs (7.62 kg) 

Temperature 0-40 degrees C

Humidity 0-95% non-condensing

Table A-5. PresentationPRO-II Communications Specifications

Parameter Specification

RS-232 DB-9 Female, DCE, 115k Baud

Ethernet RJ-45, 10/100 Mbps Autosense
124 PresentationPRO-II  •  User’s Guide

Download from Www.Somanuals.com. All Manuals Search And Download.



^K==péÉÅáÑáÅ~íáçåë
Pinouts
máåçìíë=
The following topics are discussed in this section:

• DVI Connector Pinouts

• Analog 15-pin D Connector

• Ethernet Connector

• Serial Connector

asf=`çååÉÅíçê=máåçìíë
The figure below illustrates the DVI connector:

Figure A-1.  DVI Connector

The table below lists DVI Connector pinouts.  Please note:

• T.M.D.S = Transition Minimized Differential Signal

• DDC = Display Data Channel  

Table A-6. DVI Connector Pinouts

Pin Signal Pin Signal

1 T.M.D.S. Data 2- 13 T.M.D.S. Data 3+

2 T.M.D.S. Data 2+ 14 +5V Power

3 T.M.D.S. Data 2/4 Shield 15 ground (for +5V)

4 T.M.D.S. Data 4- 16 Hot Plug Detect

5 T.M.D.S. Data 4+ 17 T.M.D.S. Data 0-

6 DDC Clock 18 T.M.D.S. Data 0+

7 DDC Data 19 T.M.D.S. Data 0/5 Shield

8 Analog Vertical Sync 20 T.M.D.S. Data 5-

9 T.M.D.S. Data 1- 21 T.M.D.S. Data 5+

10 T.M.D.S. Data 1+ 22 T.M.D.S. Clock Shield

11 T.M.D.S. Data 1/3 Shield 23 T.M.D.S. Clock +

12 T.M.D.S. Data 3- 24 T.M.D.S. Clock -

1 8

9

17 24
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^K==péÉÅáÑáÅ~íáçåë
Pinouts
^å~äçÖ=NRJéáå=a=`çååÉÅíçê
The figure below illustrates the analog 15-pin D connector:

Figure A-2.  Analog 15-pin D Connector

The table below lists Analog 15-pin D connector pinouts.  

Note that each analog input connector accepts a variety of analog formats including VGA, 
low-resolution composite video, S-video and YUV component video.  

• For RGB with H and V sync, use the VGA connector directly.

• Using a (customer supplied) VGA to 5xBNC breakout cable, five input 
combinations are possible.  Cells with check marks denote the connections 
required for the indicated format.

Table A-7. Analog 15-pin D Connector Pinouts

Pin Signal Pin Signal

1 Red 9

2 Green 10 GND

3 Blue 11

4 12

5 13 H Sync or C Sync

6 Red return 14 V Sync

7 Green return 15

8 Blue return

10 6

5 1

15 11

Table A-8. Analog Input Combinations using Breakout Cable

Breakout Cable 
Wire Color

Composite 
Video

S-Video
(Y/C)

YUV
(YPbPr)

RGB
Sync on Green

RGB
Comp Sync

RGB
Separate H V

R  (Chrom)  (Pr)  

G  (Lum)  (Lum)

B  (Pb)

H Sync

V Sync
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^K==péÉÅáÑáÅ~íáçåë
Pinouts
bíÜÉêåÉí=`çååÉÅíçê
The figure below illustrates the Ethernet connector:

Figure A-3.  Ethernet Connector

The table below lists Ethernet connector pinouts.  

Table A-9. Ethernet Connector Pinouts

Pin Signal Wire Color

1 TX Data + White / Orange

2 TX Data - Orange

3 RX Data + White / Green

4 Blue

5 White / Blue

6 RX Data - Green

7 White / Brown

8 Brown

1 8
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Pinouts
pÉêá~ä=`çååÉÅíçê
The figure below illustrates the Serial connector:

Figure A-4.  Serial Connector

The table below lists Serial connector pinouts.  

Table A-10. Serial Connector Pinouts

Pin RS-232 Signal Description

1 CD Carrier Detect

2 RXD Received Data

3 TXD Transmitted Data

4 DTR Data Terminal Ready

5 GND Signal Ground

6 DSR Data Set Ready

7 RTS Request To Send

8 CTS Clear To Send

9 RI Unused

1 5

6 9
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^K==péÉÅáÑáÅ~íáçåë
Input and Output Resolutions
fåéìí=~åÇ=lìíéìí=oÉëçäìíáçåë
This section provides a comprehensive list of available input and output resolutions, which 
you can assign to the selected input on the Input Menu, and as the system’s output format 
on the Output Menu  In Chapter 4, refer to the “Input Menu Description” and “Output 
Menu Description” sections for details. 

Input and output resolutions are listed below.  Each entry lists Format @Fv (Hz).  

• NTSC (480i) (Input Only)

• 720x480p

• PAL (576i) (Input Only)

• 720x575p

• 640x480 @59.94

• 640x480 @60

• 640x480 @72

• 640x480 @75

• 640x480 @85

• 800x600 @50

• 800x600 @56

• 800x600 @59.94

• 800x600 @60

• 800x600 @72

• 800x600 @75

• 800x600 @85

• 1024x768 @47.95

• 1024x768 @48

• 1024x768 @50

• 1024x768 @59.94

• 1024x768 @60

• 1024x768 @70

• 1024x768 @71.93

• 1024x768 @72

• 1024x768 @75

Note Please contact Barco Technical Support if you would like to 
request the addition of a new resolution.

Important PresentationPRO-II does not support interlaced output 
resolutions.  All interlaced video formats listed below are 
supported as inputs only, and noted as such in red.
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^K==péÉÅáÑáÅ~íáçåë
Input and Output Resolutions
• 1024x768 @85

• 1152x864 @75

• 1280x768 @47.95

• 1280x768 @48

• 1280x768 @50

• 1280x768 @59.94

• 1280x768 @75

• 1280x960 @50

• 1280x960 @59.94

• 1280x960 @60

• 1280x960 @85

• 1280x1024 @47.95

• 1280x1024 @48

• 1280x1024 @50

• 1280x1024 @59.94

• 1280x1024 @60

• 1280x1024 @71.93

• 1280x1024 @72

• 1280x1024 @75

• 1280x1024 @85

• 1364x768 @47.95

• 1364x768 @48

• 1364x768 @50

• 1364x768 @59.94

• 1364x768 @75

• 1364x1024 @47.95

• 1364x1024 @48

• 1364x1024 @50

• 1364x1024 @59.94

• 1364x1024 @75

• 1400x1050 @48

• 1400x1050 @50

• 1400x1050 @59.94

• 1400x1050 @60

• 1400x1050 @75

• 1680x1050 @60

• 1600x1200 @47.95

• 1600x1200 @48

• 1600x1200 @50
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^K==péÉÅáÑáÅ~íáçåë
Input and Output Resolutions
• 1600x1200 @59.94

• 1600x1200 @60

• 1280x720p @50

• 1280x720p @59.94

• 1280x720p @60

• 1920x1080p @23.98

• 1920x1080p @24

• 1920x1080p @25

• 1920x1080p @29.97

• 1920x1080p @30

• 1920x1080p @50

• 1920x1080p @59.94

• 1920x1080p @60

• 1920x1080sF @23.98

• 1920x1080sF @24

• 1920x1080i @50 (Input Only)

• 1920x1080i @59.94 (Input Only)

• 1920x1080i @60 (Input Only)

• XLM 2K @59.94

• XLM 2K @60

• 2048x1080p @50

• 2048x1080p @59.94

• 2048x1080p @60

• 1920x1200p @60

• Apple 1200p @60

• 875p
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Input and Output Resolutions
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_K==`çåí~Åí=fåÑçêã~íáçå

få=qÜáë=^ééÉåÇáñ
The following topics are discussed in this Appendix:

• Warranty

• Return Material Authorization (RMA)

• Contact Information

t~êê~åíó
All video products are designed and tested to the highest quality standards and are backed 
by a full 3-year parts and labor warranty.  Warranties are effective upon delivery date to 
customer and are non-transferable.  Barco warranties are only valid to the original 
purchaser/owner.  Warranty related repairs include parts and labor, but do not include faults 
resulting from user negligence, special modifications, lightning strikes, abuse (drop/crush), 
and/or other unusual damages.

The customer shall pay shipping charges when unit is returned for repair.  Barco will cover 
shipping charges for return shipments to customers.  

oÉíìêå=j~íÉêá~ä=^ìíÜçêáò~íáçå=Eoj^F
In the unlikely event that a product is required to return for repair, please call the Technical 
Support / Customer Service direct line, and ask to receive a Return Merchandise 
Authorization number (RMA).

• (866) 374-7878

RMA Conditions are listed below:

a. Prior to returning any item, you must receive a Return Merchandise 
Authorization (RMA) number.  

b. All RMA numbers must appear on their return-shipping label.

c. RMA numbers are valid for ten (10) days from issue date. 

d. All shipping and insurance charges on all RMAs must be prepaid by the 
customer 
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Contact Information
`çåí~Åí=fåÑçêã~íáçå
Barco Events USA/Barco Folsom, LLC
11101 Trade Center Drive
Rancho Cordova, California  95670
USA

• Phone: (916) 859-2500 

• Fax: (916) 859-2515

• Websites: 

~ www.folsom.com

~ www.events.barco.com

Sales Contact Information

• Direct:  (916) 859-2505

• Toll Free:  (888) 414-7226

• E-mail:  folsomsales@barco.com

Barco N.V. 
Noordlaan 5
8520 Kuurne
BELGIUM 

• Phone: +32 56.36.82.11 

• Fax: +32 56.35.16.51

• Website: www.events.barco.com

Technical Support / Customer Service Information 

• Tech Line:  (866) 374-7878 — 24 hours per day, 7 days per week

• E-mail: folsomsupport@barco.com
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få=qÜáë=^ééÉåÇáñ
The following topics are discussed in this Appendix:

• Software Upgrade Overview

• Serial Upgrade Method

• Ethernet Upgrade Method
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Software Upgrade Overview
pçÑíï~êÉ=réÖê~ÇÉ=lîÉêîáÉï
Firmware files for the PresentationPRO-II system are loaded into the hardware at power-
up.  These files are stored in the unit’s onboard flash memory, which can be accessed by 
using one of the following two methods:

• Serial — this method is the easiest to set up and use.  The PC connection is 
made through the Serial 1 port on the PresentationPRO-II rear panel, in 
conjunction with the “Flash Loader” utility supplied with each upgrade.  

• Ethernet — this method uses the rear panel’s Ethernet port in conjunction with a 
small network consisting of a PC (or Laptop), a network hub and the 
PresentationPRO-II unit.  However, this method still requires a serial port to be 
connected.  

The Flash Loader utility enables you to update the Flash memory with the latest software 
revision.  The utility should be run from a PC’s hard drive (recommended).  

Each upgrade method is discussed in the following sections:

• Serial Upgrade Method

• Ethernet Upgrade Method

pÉêá~ä=réÖê~ÇÉ=jÉíÜçÇ
Use the following steps to upgrade PresentationPRO-II software using a serial 
connection to your PC:  

1. Ensure that your PC (or laptop) uses the Windows® 2000 or XP operating 
systems.

2. Ensure that your PC (or laptop) has RS-232 Serial Terminal software installed, 
such as HyperTerminal.  This software enables the PC to send serial commands 
to the PresentationPRO-II unit. 

3. Download the latest PresentationPRO-II firmware update from the web:

a. On the web, navigate to http://video.folsom.com.

b. Click “Downloads” to access the Downloads Page.

c. Using the “Select Video Product” pull-down menu, click 
PresentationPRO-II.

d. In the “Software” section, click the Download button for the latest 
version of code.

e. When the File Download Dialog appears, click Save to save the file to 
your computer.

f. When the Save As Dialog appears, navigate to the desired folder (or 
create a new one) and click Save.

Note The Ethernet method is twice as fast as the Serial method. 
Using Serial takes approximately 6 minutes, while using 
Ethernet takes approximately 3 minutes.
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Serial Upgrade Method
g. After the download is complete, navigate to the target folder and double-
click the EXE to launch the installation shield.  

h. Follow the prompts to install the upgrade package in the desired folder.  
Note that at the conclusion of the procedure, a new path will be created 
under Start > Programs > Barco Folsom.  

4. Connect the Serial 1 port on the back of the PresentationPRO-II to the COM 1 
port on your PC.  In Chapter 2, refer to the “PresentationPRO-II Rear Panel” 
section on page 12 for the location of the Serial 1 port.

5. Power-up the PresentationPRO-II.

6. On the PC, click Start > Programs > Barco Folsom > PresentationPRO-II 
Software > PresentationPRO-II Flash Loader to launch the Flash Loader utility, 
as shown below.

Figure C-1.  Flash Loader Utility  

7. Click Communication > RS232 Config > Baud, and select 115200.

8. Click Communication > RS232 Config > COM Port, and select the COM port on 
your PC to which the PresentationPRO-II is connected.  If no other programs are 
using the port, the “Established communications” message appears at the 
bottom of the Flash Loader.

9. To verify communications between the PC and the PresentationPRO-II unit:

a. In the loader program, click in the black terminal window area.

b. Note the condition of the status lights:  
• DCD and CTS should be red.

Note Do not move or copy any files out of the target folder.

Note If you have not used the COM 1 port on your PC, an error 
message will be shown at the bottom of the Flash Loader.
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• TXD and RXD should be green.  They will flash if Enter is 
pressed.

Figure C-2.  Flash Loader Status Lights, Normal Condition

c. Press Enter a few times to display the system prompt “#” on screen.

d. If the prompt does not appear, continue with step 10 (troubleshooting).

e. If the prompt appears, continue with step 11 (uploading files).

10. To troubleshoot the serial connection:

a. If the DCD and CTS status lights are green, re-check the communication 
settings in the loader, and verify that the COM port and Baud Rate 
settings are correct.

b. To verify PresentationPRO-II communication settings, on the front panel 
of the PresentationPRO-II unit press {HOME} > {SYSTEM} > 
{CONSOLE} to display the Console Port Setup Menu.

Figure C-3.  Console Port Setup Menu  (sample)

c. On the menu, ensure that the following settings are selected:
• Baud Rate = 115200
• Data Bits = 8
• Parity = NONE
• Stop Bits = 1

d. Repeat steps 7 and 8 above, then re-check the status lights.  

e. With communication status OK, continue with step 11.

11. To upload files to the PresentationPRO-II unit, click the "Open script file to read 
and upload" button.

12. In the dialog, select "Upload_All.sld" and click Open.  The PresentationPRO-II 
unit should immediately display the "System in LOADER MODE" message.
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Ethernet Upgrade Method
13. It takes approximately 6 minutes to load the flash memory using the Serial 
method.  When complete, the Flash Loader utility displays the “Upload 
Complete” message.  Click OK to continue.

14. Cycle power on the PresentationPRO-II unit, and exit the Flash Loader utility.

15. On PresentationPRO-II, perform a factory reset.  

a. From the Home Menu, press {SYSTEM} to access the System Menu.

b. From the System Menu, press {RESET} to display the Reset Menu. 

c. On the Reset Type line, select FACTORY.   

d. Press {RESET}.  When the confirmation screen appears, press {YES} to 
reset the system to factory default values.

16. On PresentationPRO-II, verify that the new software has been loaded correctly:

a. From the Home Menu, press {SYSTEM} to access the System Menu.

b. From the System Menu, press {SW VER} to display the Software 
Version Menu, then verify the new version.

bíÜÉêåÉí=réÖê~ÇÉ=jÉíÜçÇ
Use the following steps to upgrade PresentationPRO-II software using an Ethernet 
connection to your PC:

1. Ensure that your PC (or laptop) uses the Windows® 2000 or XP operating 
systems.

2. Ensure that your PC (or laptop) has RS-232 Serial Terminal software installed, 
such as HyperTerminal.  This software enables the PC to send serial commands 
to the PresentationPRO-II unit. 

3. Please note the following important points:

~ Do not connect PresentationPRO-II to a Local Area Network (LAN) with 
an existing DHCP server running.

~ The factory default IP address for the PresentationPRO-II system is 
192.168.0.10, so the PC will use 192.168.0.191 as its IP address.

4. Download the latest PresentationPRO-II firmware update from the web:

a. On the web, navigate to http://video.folsom.com.

b. Click “Downloads” to access the Downloads Page.

c. Using the “Select Video Product” pull-down menu, click 
PresentationPRO-II.

d. In the “Software” section, click the Download button for the latest 
version of code.

e. When the File Download Dialog appears, click Save to save the file to 
your computer.

Warning Use caution when performing this step, as all saved files and 
saved still frames will be erased.
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Ethernet Upgrade Method
f. When the Save As Dialog appears, navigate to the desired folder (or 
create a new one) and click Save.

g. After the download is complete, navigate to the target folder and double-
click the EXE to launch the installation shield.  

h. Follow the prompts to install the upgrade package in the desired folder.  
Note that at the conclusion of the procedure, a new path will be created 
under Start > Programs > Barco Folsom.  

5. Configure a small network system consisting of a Hub, the PresentationPRO-II 
and your PC (or laptop).  Use the diagram below for reference.

Figure C-4.  Small Ethernet Network  

6. Connect the Serial 1 port on the back of the PresentationPRO-II to the COM 1 
port on your PC.  In Chapter 2, refer to the “PresentationPRO-II Rear Panel” 
section on page 12 for the location of the Serial 1 port.

7. Power-up the PresentationPRO-II and the Hub.

8. To assign a static IP address to the PC (or laptop), on the PC, click Start > 
Settings > Control Panel to display the Control Panel Window.  

9. Double-click the Network and Dial-up Connections icon to display the Network 
and Dial-up Connections Window.  

Note Do not move or copy any files out of the target folder.

Ethernet Hub / Switch

Laptop

PresentationPRO-II

Note Do not connect this small network to any other network.
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Ethernet Upgrade Method
10. Note the status of the Local Area Connection, as shown below.

Figure C-5.  Network and Dial-up Connections Window  (sample)

~ If the status is “disabled,” contact your network administrator.

~ If the status is “enabled,” right click on the Local Area Connection label 
and select Properties from the pop-up menu.

The Local Area Connection Properties Window appears:

Figure C-6.  Local Area Connection Properties Window  (sample)

11. Ensure that the Internet Protocol (TCP/IP) check box is checked.

12. Click the Internet Protocol (TCP/IP) line to highlight it, then click the Properties 
button to display the Internet Protocol (TCP/IP) Properties Dialog.
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Ethernet Upgrade Method
13. Check the “Use the following IP address” check box, as shown below. 

Figure C-7.  Internet Protocol (TCP/IP) Properties Dialog  (sample) 

14. Set the IP Address to 192.168.0.191.  

15. Set the Subnet Mask to 255.255.255.0.

16. Set the Default Gateway to 192.168.0.1.

17. When complete, click OK to close the dialog, then click OK to close the Local 
Area Connection Properties Window.

18. (Optional).  Click Start > Run to display the Run Dialog. 

a. In the Open field, type cmd, then click OK to open a DOS command 
window.  

b. In the DOS command window, type ipconfig, and verify that the new IP 
address is correct.

c. Close the DOS command window.

Note The static IP address shown above is within the unit’s user-
defined IP address range.  If this address has already been 
assigned to another device, select a different IP address 
within the following range: 192.168.0.191 → 192.168.0.240.
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19. To connect to the PresentationPRO-II serial port:

a. Click Start > Programs > Accessories > Communications > 
HyperTerminal to launch the HyperTerminal application.

b. In the Connection Description dialog, enter a connection name, 
choose an icon, and click OK.

c. In the Connect To dialog, click the Connect using pull-down menu, and 
choose COM 1.

d. Click OK to display the COM 1 Properties dialog.

e. Select the following settings:
• Baud Rate = 115200
• Data Bits = 8
• Parity = NONE
• Stop Bits = 1

20. In the terminal window, ensure that the # prompt is displayed, then type:

LOADR

.... and wait a few seconds for the > prompt.

21. In the terminal window, type:

DHCP 0

You might have to wait 10 seconds, until it binds to 192.168.0.10.

22. On the PC, click Start > Programs > Barco Folsom > PresentationPRO-II 
Software > PresentationPRO-II Flash Loader to launch the Flash Loader utility, 
as shown below.

Figure C-8.  Flash Loader Utility
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23. Click Communication > Ethernet > Connect to display the Ethernet 
Connection dialog.

Figure C-9.  Ethernet Connection Dialog  (sample)  

24. In the dialog, enter the IP address of the PresentationPRO-II:  192.168.0.10.  The 
default port number is 3000. 

25. Click the Connect button.  If the connection is successfully established, the 
message “Connect via Ethernet successful” will be shown in the Status Bar.  If 
you cannot connect, refer to the “Troubleshooting Ethernet Communications” 
section on page 145 for instructions.

26. To upload files to the PresentationPRO-II unit, click the "Open script file to read 
and upload" button.

27. In the dialog, select "Upload_All.sld" and click Open.  The flash loader echoes 
commands while the flash is being loaded.

28. It takes approximately three minutes to load the flash memory using the Ethernet 
method.  When complete, the Flash Loader utility displays the “Upload 
Complete” message.  Click OK to continue.

29. Cycle power on the PresentationPRO-II unit, and exit the Flash Loader utility.

30. On PresentationPRO-II, perform a factory reset:  

a. From the Home Menu, press {SYSTEM} to access the System Menu.

b. From the System Menu, press {RESET} to display the Reset Menu. 

c. On the Reset Type line, select FACTORY.   

d. Press {RESET}.  When the confirmation screen appears, press {YES} to 
reset the system to factory default values.

31. On PresentationPRO-II, verify that the new software has been loaded correctly:

a. From the Home Menu, press {SYSTEM} to access the System Menu.

b. From the System Menu, press {SW VER} to display the Software 
Version Menu, then verify the new version.

Note If the Ethernet menu pick is grayed out, set the COM port to 
None. 

Warning Use caution when performing this step, as all saved files and 
saved still frames will be erased.
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qêçìÄäÉëÜççíáåÖ=bíÜÉêåÉí=`çããìåáÅ~íáçåë
Use the following steps to determine the IP address of the PresentationPRO-II, and 
establish proper communications:

1. The default IP address for the PresentationPRO-II unit is 192.168.0.10. To verify 
that this is the correct address, open the terminal program and create a serial 
communication link to the PresentationPRO-II:

a. Click Start > Programs > Accessories > Communications > 
HyperTerminal to launch the HyperTerminal application.

b. In the Connection Description dialog, enter a connection name, 
choose an icon, and click OK.

c. In the Connect To dialog, click the Connect using pull-down menu, and 
choose COM 1.

d. Click OK to display the COM 1 Properties dialog.

e. Select the following settings:
• Baud Rate = 115200
• Data Bits = 8
• Parity = NONE
• Stop Bits = 1
• Flow Control = hardware/software

2. Turn on the PresentationPRO-II.

3. In the terminal window, type:

IPINFO

(or SET if in the loader)

4. Verify that the following message is displayed:

#ipinfo
Server running
IP Address 192.168.0.10
Listen Port 3000
Subnet Mask 255.255.255.0
DHCP CLIENT
DHCP Srvr IP Addr 192.168.0.11
DHCP Srvr IP Count 180
Static IP Address 192.168.0.10  

5. Ensure that Ethernet is connected from the PC to the hub (to which 
PresentationPRO-II is connected). 

6. Open a DOS command window on the PC:

a. Click Start > Run to display the Run Dialog. 

b. In the Open field, type cmd, then click OK to open a DOS command 
window.  

Note The exact static IP Address may differ.
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7. In the DOS command window, type:

ping 192.168.0.10

... and press Enter.  

~ If the computer is able to successfully communicate with the 
PresentationPRO-II, you will see a series of “replies” from the target IP 
address.

~ If you see a “Request timed out” message, the PC is unable to locate 
and communicate with the PresentationPRO-II.  If this is the case:

• Check your network connections and settings as described 
above, or ...

• Contact your network administrator.

8. With communications established, to find the current software revision:

a. Open the terminal program and create a serial communication link to the 
PresentationPRO-II unit.

b. At the PresentationPRO-II command prompt, type:

rev

... and press Enter.

Note Use the unit’s actual IP address, as determined in step 4 
above.
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